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1 Introduction to MADSEN Itera II and  
the OTOsuite Audiometry Module 

1.1 MADSEN Itera II 
MADSEN Itera II is capable of performing all standard audiometer tests, speech 
audiometry and, depending on the configuration, various special tests such as SISI, 
Stenger, ABLB (Fowler), and HIS.

Itera II can be used as a portable instrument or as a desktop unit (fixed installation).

Itera II connects to PCs running theOTOsuite Audiometry Module for online mon-
itoring of test results, data export and storage, printing, and NOAH compatibility.

Operation
Operation is simple and intuitive. The front panel buttons have indicator lights, 
which clearly show the device's current setting. Sound level, frequency and other 
information are clearly displayed on the display. 

Speech input signals can be taken from a CD player, tape recorder and internal or 
external microphones. The masking signal for speech audiometry can be presented 
together with the speech signal for the ear being examined - "Speech in Noise".

The MADSEN Itera II can be used in connection with the OTOsuite Audiometry 
Module for monitoring of test results, data export and storage, printing and NOAH 
compatibility. 

Output options
There are three output options:
• standard headphones (AC),
• bone conductors (BC)
• special output (SF), which can be connected for instance to a free-field loud-

speaker or insert phone (see available output in  5 SF TRANSDUCER  103).

Itera II can be calibrated for several types of headphones simultaneously.
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The Audiometry Module 

Transferring data to and from a pc
The test results are stored in the device - even when it is switched off. The results can 
be transferred to a PC and displayed in OTOsuite (see 9 Managing Data and 
Results  97). 

You can download new firmware to Itera II, and if this involves no change to the 
transducers, Itera II does not need to be recalibrated.

1.2 The Audiometry Module
The OTOsuite Audiometry Module software provides a comprehensive overview of 
the current stimulus and masking choices both numerically and graphically in the 
displayed audiogram(s) while testing with a connected Otometrics audiometer.

As the module is part of OTOsuite, audiograms can be used directly in other OTO-
suite modules such as AURICAL Visible Speech for an optimized workflow inde-
pendent of NOAH.

The OTOsuite Audiometry Module lets you work with NOAH or save and view 
results via XML files.

The current version supports 
• basic tone audiometry and
• speech testing
• special tests, depending on the audiometer being used.

Masking AssistantTM

The special Masking AssistantTM feature will notify you of thresholds that you might 
consider checking again with masking applied. You may use this feature not only dur-
ing testing but also to pinpoint possible masking issues with previously recorded 
audiograms. The applied masking rules match the general recommendations in the 
audiometry literature.

Over the rim testing
Testing with the audiometer connected to a PC allows you to use the audiometer pri-
marily as a handy control panel while you follow the actual stimulus settings and test 
progress on your standard PC display. The large stimulus and patient response graph-
ics at the top of the display gives you a clear overview while keeping your focus on 
the patient.

Patient test planning
The OTOsuite Audiometry Module supports planning of patients for safe offline 
testing in the field. You create a list of patients that can then be downloaded to audi-
ometers supporting patient planning (MADSEN Xeta). Each planned patient can 
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now be safely identified, selected and tested on the audiometer based on his name 
and personal identification. The results can be bulk uploaded to the PC later on.

For specific information regarding audiometric test procedures and settings, please 
see the documentation for the specific audiometer.

1.2.1 OTOsuite Audiometry Module interfacing to audiometers

The OTOsuite Audiometry Module is designed to interface with the following test 
devices produced by Otometrics

Audiometers produced by Otometrics:
• MADSEN Xeta (Air, Bone, Masking)
• MADSEN Itera II (Air, Bone, Masking, Speech) 
• MADSEN Astera (Air, Bone, Masking, Speech, special tests)
• AURICAL Plus and MADSEN Conera (download of data via LINK).

1.3 Intended use

1.3.1 MADSEN Itera II 

Itera II is intended for diagnostic and clinical use by audiologists and other health 
care professionals in testing the hearing of their patients.

1.3.2 The Audiometry Module

The OTOsuite Audiometry Module is intended for screening and diagnostic use by 
audiologists and other health care professionals in testing the hearing of their 
patients.

1.4 About this manual

Installation
See 13 Unpacking and Installing MADSEN Itera II  127 and 3 Overview of 
MADSEN Itera II  17 for a full description of unpacking instructions, controls 
and socket connections.

Safety
This User Manual contains information and warnings which must be followed to 
ensure the safe performance of Itera II. 

Warning · Local government rules and regulations, if applicable, should be followed at 
all times. 
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• App. 4 Standards and safety - MADSEN Itera II and the Audiometry 
Module  145 
gives you an overview of device labelling and standards.

• App. 4.1.2 Warning notes  145 
contains relevant warning notes.

Training
It is recommended that you read this manual and the OTOsuite Platform User Man-
ual, and make yourself familiar with Itera II before you begin testing a patient.

Note · If you are using the OTOsuite Audiometry Module with NOAH 3, we recom-
mend that you are familiar with the screens and functions provided in NOAH 3.

Terminology
The correct term for the person being tested/evaluated/serviced may depend on the 
setting in which the system is being used. For this manual the term “Patient” was cho-
sen, but when you use Itera II with OTOsuite, you can configure OTOsuite to use 
another term.

1.5 Typographical conventions

The use of WARNING, CAUTION and NOTE
For safety reasons and appropriate use of the OTOsuite Audiometry Module, the 
manual contains WARNINGS, CAUTIONS and NOTES, which you should read care-
fully. The use of these headings is denoted as follows:

Warning · Indicates that there is a risk of danger to persons and data.

Caution · Indicates that there is a risk of damage to data.

Note · Indicates that you should take special notice.

1.5.1 Navigation in this manual

Menus, icons and functions to select are shown in bold type, as for instance in:

• Click the Set options icon on the toolbar or select Tools > Options... 
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2 Getting started with MADSEN Itera II and  
the OTOsuite Audiometry Module

2.1 Unpacking Itera II
1. Inspect the package and its contents for possible visual damage. 
2. Check with the packing list to make sure that you have received all necessary 

parts and accessories. If your package is incomplete, contact your supplier. 

2.2 Getting started
1. If you are using OTOsuite, install OTOsuite from the OTOsuite Installation 

CD. See the OTOsuite User Manual. 
2. Install Itera II as described in 13 Unpacking and Installing MADSEN Itera 

II  127.
3. Connect the accessories, 13.2 Installation  127:

– Connect the Patient Response Switch.
– Connect headphones/insert phones.
– If bone conduction is required, connect the bone conductor.
– Connect external and Free Field microphones if required.
3.3 Socket connections - rear panel  31 shows the location of the sockets for 
the various accessories required.

4. Customize and prepare the test equipment:
– 2.3 Customization  15
– 5 Preparing MADSEN Itera II for the test  59

5. Switch on Itera II. Itera II is ready for testing as soon as it is switched on.
6. Launch the OTOsuite Audiometry Module, if required.
7. Itera II automatically starts in manual test mode.
8. You are ready to start testing.

Itera II controls
3.2 FRONT panel controls  19
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Getting started 

Test types
• Manual air conduction testing 

To perform manual air conduction testing, see 6.1 Air Conduction threshold 
test  65.

• Bone conduction testing 
To perform bone conduction testing, see 6.2 Bone Conduction threshold 
test  67.

• Speech testing 
To perform speech testing, see 7 Speech Audiometry with MADSEN Itera 
II  75.

• Special tests 
8.1 MCL tone testing  83 
8.2 UCL tone testing  83 

Erase
Frequency selection 

knob

Present/interrupt signal word 
count buttons

Start/Pause

Store/toggle status of thresholds

Tests

Transducers

Signal
Input

Signal indicators

Ext. range/LR

Setup

Masking
dB

Display

Stimulus/masking intensity knobs



Otometrics 15

 Getting started with MADSEN Itera II and the OTOsuite Audiometry Module 

Customization

8.3 SISI Test  83,  
8.4 ABLB (Fowler)  86,  
8.5 STENGER Test  87,  
8.6 Hearing Instrument Simulation (HIS)  88
Press SPECIAL. Three special tests will be shown on the display. 

Press the function key below the test you wish to perform. If your Itera II is con-
figured with more than three special tests, press SPECIAL until you see the test 
you wish to use.

These tests are optional. To add any of these tests to your configuration, contact 
your local supplier.

2.3 Customization
With Itera II you can quickly and easily customize your test sequences for maximum 
efficiency.

2.3.1 Customizing your Setup

Make the changes you want in the setup of Itera II and save these changes in the spe-
cific test setup.

Example
1. Set dB STEP to 1 dB (press button 1 in the dB STEP column).
2. Press SETUP twice to enter setup mode.
3. Turn the Left dB LEVEL knob until “SAVE TEST SETUP” is shown on the dis-

play.
4. Press STORE.
5. Turn Itera II off and then on again. It now remembers your preferred settings.

2.3.2 Shortcuts

A number of functions in Itera II can be activated by a shortcut so that you just have 
to press and hold the appropriate button and turn the knob.

For a full list of shortcuts, see 10.2.3 Temporary changes in the setup  100.

Example
1. Press the SPEECH button to select Speech mode.
2. Press MIC to select microphone.
3. Press and hold MIC while you turn the right LEVEL knob. You will then adjust 

the sensitivity of this microphone.
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3 Overview of MADSEN Itera II

Display
Settings and the test as it progresses are shown on the display. See 3.1 Display  17.

Front panel
Itera II is operated from the front panel. See 3.2 FRONT panel controls  19. 

Rear panel connections
The rear panel contains the sockets for connecting various accessories and the socket 
for power connection. See 3.3 Socket connections - rear panel  31.

Side panel
The side panel contains the ON/OFF switch. See 3.4 Side panel  34.

3.1 Display
The display is placed in the top center of the front panel.

Fig. 1 Itera II front panel

During startup the display briefly shows information regarding the device type and 
version, and then shows the test screen last used.

20
TON

0
NBN2000 RL

ox
*

Test signal indicator Stored thresholdAudiogram symbols

Ear indicatorEar indicator

Function key markers

Signal Signal
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Display 

The abbreviations used on the display are explained in App. 2 MADSEN Itera II 
Abbreviations  135.

Top line
• During Tone testing the upper line in the display shows the intensity numeri-

cally in dB HL for the left and right ear. 
• For Speech testing and HIS the upper line is transformed into one or two VU 

meters. 

Ear selection

The ear being tested is indicated with L or R in the display. The display side for L and 
R can be changed in the settings. See  36 DISPLAY  111.

Frequency

The selected test frequency for tone testing is shown at the center. 

Masking
If masking for the contralateral ear is enabled, this is shown on the opposite side. 

Symbols used

 
Right ear

Resp./No resp.
Left ear

Resp./No resp.

Air, unmasked

Air, masked

20
TON

0
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ox
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Signal Signal

20
TON
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3.2 FRONT panel controls
You can access all basic functions directly by using the buttons and knobs on the Itera 
II front panel.

The button light indicators
Each button has its own function. Some buttons have a light to indicate whether the 
function is currently active or not.

• Press the button to activate.
• Press the button again to deactivate.

Bone, unmasked

Bone, masked

Sound field, unmasked 
(binaural - applies to 
both ears)

Sound field, masked

UCL (UnComfortable 
Loudness level)

MCL (Most Comforta-
ble Loudness level)

Other symbols

Stored results on this frequency

Right ear
Resp./No resp.

Left ear
Resp./No resp.
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3.2.1 Front panel layout

The Itera II buttons and controls are grouped according to their function and how 
frequently they are used. The layout is shown in Fig. 2  20.

The buttons and knobs most frequently used are placed directly below the display.

Fig. 2 The Itera II controls and display

Beep
If you try to use a button which is not enabled, you will hear two short beeps. Itera 
II also beeps when the SISI test is completed.

Erase
Frequency selection 

knob

Present/interrupt signal word 
count buttons

Start/Pause

Store/toggle status of thresholds

Tests

Transducers

Signal
Input

Signal indicators

Ext. range/LR

Setup

Masking
dB

Display

Stimulus/masking intensity knobs
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3.2.2 The TEST column

Press to select the test:

• TONE 
Press TONE to select the Tone Threshold test.

• SPEECH 
Press SPEECH to select the Speech test.

• SPECIAL
Press SPECIAL to see the optional test types. Press the appropriate function key 
to select. On versions of Itera II supplied with more than three special tests, press 
SPECIAL again while its LED is flashing. This will display the names of more 
Special tests. 

The most recently used Special test always appears in the first row the next time 
you select SPECIAL. 

For a description of the special tests, see

– 8.1 MCL tone testing  83
– 8.2 UCL tone testing  83
– 8.3 SISI Test  83
– 8.4 ABLB (Fowler)  86
– 8.5 STENGER Test  87
– 8.6 Hearing Instrument Simulation (HIS)  88

Current test settings
When you switch to a new test, the current setting of the test that you are leaving will 
be saved and re-established when you return to the test.

3.2.3 The TRANSD. column (transducers)

Press to select the output transducer:

• AC 
Press AC to select the Air Conductor

• BC 
Press BC to select the Bone Conductor

• SF 
Press SF to select the Special Transducer

The identity of the transducer selected under SETUP is displayed as long as you press 
the button. 
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If a headphone/transducer is not selected under SETUP,  3 AC 
TRANSDUCER  102,  4 BC TRANSDUCER  102 and  5 SF 
TRANSDUCER  103, the relevant transducer cannot be selected. 

3.2.4 The SIGNAL column

WARBLE
Presentation of warble tone stimulus (WRB).

PULSE
The test signal is presented with a Pulse/Pause ratio of 50%. 

IMPULSE
The test signal is presented within a preset period of time.

Warble shortcut functions

Warble frequency To change the warble frequency, press and hold WARBLE, 
while you turn the left LEVEL selector.

Warble modulation To change warble modulation width, press and hold 
WARBLE, while you turn the right LEVEL selector.

Pulse shortcut functions

Pulse frequency To change the pulse frequency, turn the right LEVEL 
selector while you press and hold PULSE.

Impulse shortcut functions

Test signal duration To change the duration of the test signal, turn the right 
LEVEL selector while you press and hold IMPULSE.
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3.2.5 The MIC, CD and REVERSE column

MIC.
Press MIC. to select the signal from external or internal microphone input. The inter-
nal microphone is located below the display. External microphones are for instance 
the gooseneck microphone, or, if you are using a monitor headset, the boom micro-
phone.

CD.
Press CD to select the signal from external CD/TAPE input.

REVERSE
Press REVERSE to toggle the function of the Interrupter between:

• REVERSE (lamp lit) 
If REVERSE is on (the test signal is activated continuously), the test signal is 
interrupted when you press INT. 

• Normal 
The test signal is applied when you press INT.

Note · The presentation only applies to the test signal. The masking signal is normally 
always ON. You can change the masking interrupter's function under SETUP,  9 MASK. 
PRESENT.  103.

The permitted signal source depends on the TEST selected, see 3.1 Display  17.

Speech and HIS
• Press REVERSE to toggle the signal.

3.2.6 The OUTPUT test signal indicators

The OUTPUT indicators are located on either side of the display. They light up 
when the selected test signal is present in the corresponding ear. 

3.2.7 The ERASE button

This button has several functions:

MIC/CD shortcut functions

Input signal sensitiv-
ity, MIC/CD

You can adjust the input signal sensitivity by holding 
down the MIC or CD button and turning the LEVEL selec-
tor that is closest to the test signal side.
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Deleting all audiogram data
You must delete all data before you start testing on a new patient.

• Press ERASE to clear all data.
The following dialog appears :

Erase all data ? 
YesNo

To delete all data, press the function key below YES.

To cancel the ERASE command, press the function key below NO.

Note · Switching off the power does not erase stored thresholds from the memory.

Additional functions
• Speech Audiometry and many special tests: 

Various counter values: Press to reset to zero.
See the description of • SPECIAL  21, and 8 Special tests with MADSEN 
Itera II  83), 

• SISI: 
Press to stop test completely during the pause.
Press to delete data at a specific frequency if it is activated during a test (see 
8.3 SISI Test  83).

3.2.8 The XMIT button

This button is not active.

3.2.9 The MIC. (microphone)

The internal microphone for Talk Over and Speech testing. 

Use this microphone as an alternative to the gooseneck microphone or the boom 
microphone on the monitor headset.

3.2.10 The TALK OVER button

Enables communication with the patient who may be sitting in a sound booth. The 
signal from the internal microphone or the right Speech microphone is sent to the 
patient's headset while the button is pressed. 
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The test signal and any masking signal is interrupted during this period.

When you release the button the test signal returns.

Shortcut functions
When you press and hold TALK OVER (see  25 TALK OVER  110), you can adjust 
the following:

The change-over from "INTERN." to "EXTERN." occurs automatically if an exter-
nal microphone is connected (see Fig. 3  32).

3.2.11 The RESPONSE indicator

Lights up when the patient presses the Patient Response switch. You will hear a 
“beep” at the same time.

For a description of the Patient Response Switch, see 5.2.2 The patient response 
switch  60. 

3.2.12 The START/STOP button

Press to Start, Stop or Pause the counter/timer function in different tests as 
required.

• SISI 
Press to Start/Stop and Pause.

• HIS 
Press to activate the filters.

Talk over shortcut functions

Output level, head-
phone

Left LEVEL selector 
Adjusts the output level in the headphone (dB HL).

Fixed dB level, talko-
ver level

Frequency selector 
Switches between the fixed dB level (FIX) displayed and a 
talkover level related to a mean of the saved thresholds 
(THR) for the following frequencies: 

250, 500, 1000, 2000 and 4000 Hz.

MIC sensitivity Right LEVEL selector 
Sets Mic sensitivity.

Talkover signal to 
headphone

Left/Right arrow button 
Controls the Talk Over signal to the right or left head-
phone. Press twice to transmit the signal to both ears.
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3.2.13 The STORE button

Stores a threshold in the internal memory. This button is not applicable in Speech 
testing.

• If you press and hold STORE, it toggles the threshold status and symbol shown 
on the display between “threshold value”, “No response” or no symbol. Release 
the button when it shows the wanted status. 
You can overwrite a stored threshold value with a new value. 

You can delete an accidentally stored threshold: Press and hold STORE until no 
symbol is shown.

Note · In UCL and MCL testing 
“No response” is not applicable.

• If a previously stored threshold is present, it will be replaced by the new thresh-
old when you press STORE. 

Change frequency after STORE
You can set up the STORE button to automatically change the stimulus to the next 
test frequency. See SETUP,  13 FREQ.CH.AT STORE  104.

When you select a frequency and intensity at which a threshold value has previously 
been found, this value is shown in the display by means of an "*" symbol beside the 
frequency indication, and the applicable audiogram symbol beside the level indica-
tion, depending on the selection of ear, masking and transducer type.

3.2.14 The EXT. RANGE button

Enables presentation of stimuli above the safety limit (approx. 100 dB). The safety 
limit is set to 20 dB below the maximum dB HL for a given transducer and fre-
quency. The exception is at 125 Hz, where the limit is 30 dB below the maximum 
dB HL.

Extended Range has three modes (to select, see SETUP,  32 EXT. RANGE  111):

• Auto 
All levels at all frequencies are always accessible, but the EXT. RANGE button is 
lit when a level above the safety limit is reached.

• Manual 
You must manually press the EXT. RANGE button to test above the safety limit.

• Timeout 
Selection of the time interval that passes between the device standing untouched 
and the EXTended (sound intensity) RANGE is deactivated.

EXT. RANGE is automatically disabled:
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• when the intensity falls below the limit selected under SETUP  33 EXT.R. dB-
SPACE  111,

• when the duration set for Ext. Range Timeout is exceeded and the device has 
been inactive (SETUP,  32 EXT. RANGE  111),

• when you select a new test, or
• when you change FREQUENCY, see 3.2.20 The FREQUENCY knob  29.

3.2.15 The L <--> R button

• Press this button to switch between testing the left and right ear.
• Speech test 

Press twice (L+R) during the speech test to send the test signal to both ears, giv-
ing "Binaural Speech".
Use L <--> R to mix the signals in speech testing.

Use L <--> R to control setup masking in one ear in binaural speech testing.

3.2.16 The SETUP button

Changing the setup temporarily 
To change the setup of Itera II temporarily:

• Use the Shortcut function. See 10.2.3 Temporary changes in the setup  100. 
These changes will not be saved when you switch off Itera II.

Changing the setup permanently 
To change the setup of Itera II permanently: 

Use the SETUP button to access the various parameters. See 10.2.1 Permanent 
changes in the setup  99.

1. Press SETUP twice to change default settings, see 10 Setup of MADSEN Itera II 
Parameters  99.
Pressing SETUP twice to access the setup function serves to prevent accidental 
changes in the setup.

– SISI 
Press SETUP to enable the number of small increments to be changed using 
the right LEVEL selector.

– Fowler (ABLB) 
Press SETUP to enable changing the frequency of the alternating tone using 
the right LEVEL selector. 
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3.2.17 The TALK BACK button

The patient's speech is always fed back to the operator's monitor headphone. 

You can remove the signal 

• by lowering the Talk Back volume (SETUP,  26 TALK BACK MIC.  110), or 
• by setting the switch on the Talk Back microphone to OFF. 
You can choose to have the test signal and/or the masking signal switched ON or 
OFF in the monitor headphone (SETUP,  27 MONITOR ON/OFF  110).

3.2.18 The MASK column

OFF 
No masking

ON 
To adjust the masking intensity independently of the signal level use the right LEVEL 
selector.

LOCK 
Makes the masking level follow the stimulus signal level. You can adjust the differ-
ence between the stimulus signal and the masking signal by using the right LEVEL 
selector.

Note · By default, you can only adjust the test signal volume by using the LEFT selector, 
regardless of whether you are testing the right or left ear. 

To adjust the masking signal volume use the RIGHT selector. To change the default 
setting, select SETUP,  37 STIMULI KNOB  112.

Talk back shortcut functions

Setup - volume To adjust the volume, press and hold TALK BACK while 
turning the right LEVEL selector. 



Otometrics 29

 Overview of MADSEN Itera II 

FRONT panel controls

3.2.19 The dB STEP column

Choose between the following attenuator steps:

1 dB 
2.5 dB 
5 dB

If the indicator light on the selected button flashes, this indicates that the display has 
been set up to show SPL values (SETUP,  22 SIGNAL UNIT  109) instead of HL.

3.2.20 The FREQUENCY knob

Change of frequency. 

When you turn the knob clockwise, the frequency is increased and when you turn 
the knob counter-clockwise, the frequency is decreased. 

Both octave and inter-octave frequencies are available when you use the Frequency 
knob. The exception is 125 Hz, which follows the setting in SETUP,  20 SELECT 
AC FREQ.  109 

MASK shortcut functions

Masking transducer 
selection

When masking is already selected and you press the same 
masking button once more, the masking transducer, the 
masking signal type and the name of the transducer + (if 
applicable) the serial no. appear in the display. 

The transducer button flashes and you can then select a 
different masking transducer by pressing one of the three 
TRANSD buttons AC, BC or SF.

Masking noise in 
Speech

Select the masking ear: press and hold MASK ON and 
press L <--> R to toggle between left, right and both ears.

FREQUENCY shortcut functions

Display graphs, HIS 
mode

If you turn this knob in HIS mode, various graphs will be 
shown (see 8.6 Hearing Instrument Simulation 
(HIS)  88).



30 Otometrics

Overview of MADSEN Itera II  

FRONT panel controls 

3.2.21 dB - LEVEL - Left

Intensity change
Changes the intensity for the test signal regardless of whether the signal is being sent 
to the left or right ear! To change this setting, select SETUP,  37 STIMULI 
KNOB  112. 

When you turn the knob clockwise, the intensity is increased and when you turn the 
knob counter-clockwise, the intensity is decreased. 

Masking and intensity
If the masking signal is in LOCK mode the intensity is also changed here. 

Shortcut functions

3.2.22 dB - LEVEL - Right

Intensity change
Changes the intensity of the masking signal in the selected dB steps. To change this 
setting, select SETUP,  37 STIMULI KNOB  112. 

When you turn the knob clockwise, the intensity is increased and when you turn the 
knob counter-clockwise, the intensity is decreased. 

Shortcut functions
You can also use the right LEVEL selector to 

dB LEVEL left - shortcut functions 

Warble modulation Select the warble frequency,.

Signal type, SISI The signal type for the SISI test.

Master volume, HIS The master volume value to be changed in HIS.

Parameter selection, 
SETUP

Parameter selection in SETUP.

dB LEVEL right - shortcut functions

Talkback level Set the level of Talk Back.

Warble modulation, ampli-
tude

Warble frequency (in SETUP) and amplitude.

Pulse frequency Pulse frequency, 

Impulse time Impulse time, 
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3.2.23 Left INT button (FAIL)

Presentation of test signal. This function depends on whether presentation mode is 
set to normal, or REVERSE is activated. This is shown by the output indicator (see 
3.2.6 The OUTPUT test signal indicators  23). 

Normally the test signal is present when you press the button.

If you press REVERSE the test signal disappears.

• Speech testing 
Press this button to count "unheard words" (FAIL).

3.2.24 Right INT button (PASS)

Usually functions in total parallel with the left INT button. 

Use the right INT button to control the masking signal. This will either present or 
interrupt the masking signal depending on the setting in SETUP,  9 MASK. 
PRESENT.  103.

• Speech testing 
Press this button to count "heard words" (PASS).

• SISI 
Use the right INT button to register "Pass" when the patient is unable to use the 
Patient Response switch.

3.3 Socket connections - rear panel
The socket connections on the back of Itera II are protected by a guard, which is 
hinged onto the front panel and held shut by a spring-clip at each end. Open this 
guard in order to connect or disconnect accessories or cables to the back of Itera II. 

Input sensitivity, speech Input sensitivity for speech testing.

Word counting method, 
speech

Choice of word counting method for speech test-
ing.

Alternating Fowler frequency Alternating Fowler frequency.

Master volume, HIS Master volume value selection in HIS.

Parameter selection, SETUP Parameter selection in SETUP.

Power out voltage DC POWER OUT voltage.

dB LEVEL right - shortcut functions
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Fig. 3 Itera II rear panel

3.3.1 Description

SF (AC)
To the "SF Transducer output". Here you can connect any headphone or free field 
system. 

Connect the blue 1/4" jack plug for left (SF Left) and the red 1/4" jack plug for right 
(SF Right).

AC
Connection for the AC transducer to the enclosed headphone. Blue 1/4" jack plug 
for left (AC Left) and red 1/4" jack plug for right (AC Right).

BC
Connect the black 1/4" jack plug from the bone conductor.

CD/TAPE
Connection of CD or tape recorder - Left (1) and Right (2).

Caution · When you connect other electrical equipment to Itera II, remember that 
equipment that does not comply with the same safety standards as Itera II can lead to a 
general reduction in the system's safety level. 

Note · It is recommended that the Itera II supplies power to the CD/Tape player.

EXTERNAL MIC./MONITOR HEADSET
Connection for the gooseneck microphones for speech audiometry or monitor head-
set with internal microphone.

MONITOR
Connection for the monitor head set without internal microphone. Can be used if a 
stereo microphone is connected to EXT. MIC./MONITOR HEADSET.

TALK BACK
Connection for the Talk Back microphone, for communication from patient to oper-
ator. Set the switch on the Talk Back microphone to ON.

RS232 
interface

DC power 
out 1.5-10V

Patient 
Response

Digital aux. Talk Back Monitor Ext.Mic./
Monitor 
headset

CD/Tape 
Right/Left 

(2)   (1)

SF(AC)  AC 
Right

BC AC  SF(AC) 
Left
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DIGITAL AUX
N/A.

PATIENT RESPONSE
Connect the black 1/4" jack plug from the Patient Response switch. When the 
patient presses the Patient Response switch, this lights the RESPONSE indicator 
light and gives an audible "beep" from Itera II.

DC POWER OUT
Power supply for the CD/TAPE player. Adjustable from SETUP,  35 CD POWER 
SUPPLY  111 (OFF and 1.5 - 10 volt DC, 500 mA). Use the right LEVEL selector 
to select.

Note · Remember to use an adapter if necessary so that the CD has the correct polarity. 
The centre pin is + and the sheath is 0V.

Note · It is recommended that Itera II supplies power to the CD/Tape player.

RS 232 INTERFACE
To connect Itera II to a PC, use the optional 9-pole PC- RS232 interface cable.

The installation must be carried out in accordance with EN 60601-1-1 plus adden-
dum in the form of Part 1: General provisions -1 and UL2601-1  CAN/CSA-C22.2 
NO 601.1-90. The supplementary provisions on the reliability of electro-medical 
systems.

It is a general rule for all electrical equipment used in the proximity of the patient 
that:

• The connected equipment must comply with EN60601-1 and/or EN60601-1-
1.

Any PC connected to Itera II must comply with the requirements of IEC 950, 
"Safety of information technology equipment, including electrical business equip-
ment".

For information on how to use Itera II with a PC, see 9 Managing Data and 
Results  97.

Supply voltage connection
100-240 V AC, 50/60 Hz, 60 VA 
Fuses: 2   T 1A L/250 V, 5 mm   20 mm.

2

1
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Side panel 

Warning · Before you replace a fuse, first switch off the instrument and disconnect it 
from the mains power supply. See 12.2.3 Replacing fuses  124.

3.4 Side panel
Power ON/OFF

3
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4 Navigating in the OTOsuite Audiometry Module

The general functions for navigating in the main window are described in the OTO-
suite manual.

Audiometry elements

Screen descriptions
You will find descriptions of the actual screens and how to use and view them in:

4.5 The Tone test screen  45 
4.6 The Speech test screen  48 
4.7 The Aided Speech test screen  51

4.1 Audiometry Module features

Note · Some of the features below are device-dependent.

With the Audiometry Module, you can 
• perform testing, using the Audiometry Module as a handy control panel while 

you follow stimulus settings and test progress on your PC display

Audiometry toolbar

Work area

Control Panel

Stimulus bar

Stimulus marker

Masking level indicator



36 Otometrics

Navigating in the OTOsuite Audiometry Module  

The Audiometry Module menu system and toolbar 

• view and print test results
• view historic audiometry results from NOAH or XML
• view online audiometry results during testing

– Tone testing
– Speech testing 

• use the Masking Assistant to prompt when masking is recommended
• view the masking level indicator in audiogram
• view audiogram overlays
• enter tester details and test date entry for manually entered audiograms
• enter special test and tuning fork test results
• perform “over the rim” testing, using the audiometer as a handy control panel 

while you follow stimulus settings and test progress on your PC display

4.2 The Audiometry Module menu system and toolbar
The Menu bar is located at the top of the window. Some of the menu items are also 
available as icons.

The icons available in the Toolbar depend on the test functions included in your 
OTOsuite and/or whether a test device is connected. 

General icons

The general OTOsuite menu system and toolbar are described in the OTOsuite User 
Manual.

Audiometry icons

Some of the icons in the Audiometry toolbar are toggle icons. Click to toggle to 
another selection.

The menu selections and toolbar specific to the Audiometry Module are described 
below.

Note · Some of the menu selections and functions are device-specific, and may not apply 
to your setup.
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The Audiometry Module menu system and toolbar

File/OTOsuite menu

Edit menu

View menu

New Audiogram 

• Click to select new audiogram. You will be 
prompted to save or cancel current data.

Audiometric properties... (Ctrl+U)

• Click to enter Tester name, Test Date, and air 
conduction transducer for a manually entered 
audiogram. 

Note · The air conduction transducer is stored when 
you have selected it in the transducer section of the Con-
trol Panel and data points are entered on the audiogram.

Masking Assistant

 

• Click to enable or disable the Masking Assistant. 
The Masking Assistant causes an unmasked 
threshold to flash repeatedly if masking is recom-
mended.

Overlays

• Click to enable or disable the overlays. Overlays 
display pictures, severity, speech banana, speech 
letters, and/or unusable area on the audiogram. 

Note · Overlays can also be displayed by selecting them 
from the overlay box below or next to the audiogram. To 
view/hide the overlay box, select Tools > Options > 
General. 
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The Audiometry Module menu system and toolbar 

Combined Audiogram

Combined View
• Menu item: 

Click to toggle between viewing both ears in a 
single audiogram (combined audiogram) or both 
a left and a right audiogram on your screen.

• Icon: 
Click to view both ears in a single audiogram.

Split View
Icon: 
Click to view separate audiograms for each ear.

Left - Right Menu item: 
Click to display the left ear audiogram on the left side 
of the window and the right ear audiogram on the 
right side of the window (when Split view is enabled).

Right - Left Menu item: 
Click to display the right ear audiogram on the left 
side of the window and the left ear audiogram on the 
right side of the window (when Split view is enabled).

Audiogram Legend

Click to enable or disable the display of the audio-
gram legend. The legend contains the most com-
monly used symbols for the audiogram. It is not 
configurable.

Standard / All / High frequencies

Frequency range
Click to choose between viewing:
• Standard frequencies
• All frequencies
• High frequencies

Standard frequencies
Displays the audiogram from 125 to 8000 Hz.
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The Audiometry Module Control Panel

Tools menu

Additional icons

4.3 The Audiometry Module Control Panel

Note · The appearance of the Control Panel depends on the test device used.

All frequencies
Displays the audiogram from 125 to 20,000 Hz.

High frequencies
Displays the audiogram from 8000 to 20,000 Hz.

Curves and Symbols

• Click to select the Curves and Symbols dialog 
box. 

This dialog box and its related function are spe-
cific to configuring the curves and symbols to be 
displayed on the audiogram or speech graph dur-
ing testing.

See 4.9 Curves and symbols selection  52.

Fetch test results... 

• See description in 5.5 Fetch test results from 
audiometer  63.

Options

• See description of how to work with user options 
and User Tests in the OTOsuite User Manual.

Import Audiometry Data

Click to import audiometry data from AURICAL 
Plus and MADSEN Conera. See the OTOsuite User 
Manual.

Standard / All / High frequencies
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The Audiometry Module Control Panel 

The general function of the Control Panel is described in the OTOsuite User Man-
ual.

The Audiometry Module Control Panel shows the settings available for the specific 
test in the connected audiometer. 

Fig. 4 The MADSEN Itera II Control Panel

4.3.1 The MADSEN Itera II Control Panel

When you activate the Audiometry Module Control Panel, OTOsuite automatically 
connects to your Otometrics audiometer and displays the Control Panel. You cannot 
operate MADSEN Itera II from the Control Panel.

This Control Panel is divided into a number of sections, where you can view various 
settings, and a section for controlling communication with the audiometer.
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The Audiometry Module Control Panel

   

Control Panel

The Stimulus Panel

The Stimulus Panel shows the stimulus type 
used and the selected test ear. Refer to your 
Audiometer manual for a description of availa-
ble stimulus types.

The Masking Panel

The Masking Panel shows the masking used and 
the selected test ear. Refer to your Audiometer 
manual for a description of available masking 
types.

The Test Panel

The Test Panel shows the test type used. Refer to 
your Audiometer manual for a description of 
available test types.

Binaural headset

Stimulus

L

Warble

Narrow Band Noise

Binaural headset

Masking

R

Manual Audiometry

Test
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The stimulus bar 

4.4 The stimulus bar

During online testing, the stimulus bar shows:
• The stimulus and level being presented.
• Stimulus type.
• The current frequency.
• Masking, when presented, and masking level.
• Masking type.

The Connection Panel

Note · If there is a risk that patient selected in 
the audiometer does not correspond to the patient 
shown in the OTOsuite or NOAH status bar, a 
warning triangle will be shown on the screen. 

• Make sure that you select the correct 
patient, either in the audiometer or in 
OTOsuite.

Connection

Connected to the audiometer

Patient selection in audiometer 
may not match the patient in 
OTOsuite

Intensity

Indicated by the dB level above the channel status bars. 
• Masking is denoted by square brackets around the level (calibrated in effective 

masking level). 
• The green triple wave symbol above the level indicates that the stimulus is 

currently being presented.

Stimulus  
indicator

Transducer  
indicator

Routing  
indicator

Masking on

Stimulus being 
presented

Intensity

Stimulus bar colour
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The stimulus bar

Stimulus marker 
• The stimulus cross is your visual aid to identify the frequency and level being 

tested.

The Masking level indicator 
• The masking level indicator is shown behind the curves and symbols when when 

masking is on. 

Stimulus bar color

Indicates the routing for each channel:
• Blue = left ear
• Red = right ear
• Blue/Red = binaural
• Gray = unspecified 

Stimulus, transducer and routing indicators

The stimulus/masking type, the transducer and the routing for each channel.

Stimulus marker

Masking level indicator
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The stimulus bar 

4.4.1 The Tone stimulus bar 

Fig. 5 Features specific to the Tone stimulus bar

During online testing, the stimulus bar shows:

4.4.2 The Speech stimulus bar

Fig. 6 Features specific to the Speech stimulus bar

During online testing, the stimulus bar shows:

• Symbol 
Indicates the symbol being used when storing a data point (i.e. blue square - 
indicating left masked air conduction threshold).

• Frequency 
Indicated by the Hz value in the center of the stimulus bar.

Symbol Frequency

• Speech Score/Word Count 
Displays the percentage correct/incorrect and the amount of words cor-
rect/incorrect out of a given number of words. You can display speech score and 
word count either as “% Correct” or as “% Incorrect”. To set your preference, 
select Tools > Options > Speech > View > Score Presentation.

• VU Meter 
Displays the sensitivity of the test microphone or speech material.

Speech score,  
word countVU meter

Masking On

Stimulus being 
presented
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The Tone test screen

4.5 The Tone test screen
During online testing, the screen reflects the test done by the audiometer as it 
progresses. 

4.5.1 The work area in the Tone screen - the audiogram

The audiogram of the selected Client is displayed.

During testing, the threshold symbols are entered automatically in the audiogram.

You can choose between 

Tone testing - combined view audiogram

Stimulus marker

Legend box

Work area

Stimulus bar

Cross Hatch

Indicates your current stimulus level and frequency. 
The color of the cross hatch indicates the routing: 
• Blue = left, 
• Red = right, and 
• Black = binaural

Click the Combined view icon to select.
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The Tone test screen 

Fig. 7 Tone testing - combined view audiogram

Tone testing - split view audiogram

Fig. 8 Tone testing - split view audiogram

4.5.2 Tone view options

You can access a number of tone display options directly from the Tone main screen.

• Overlays 
Select the overlay that will be displayed on the audiogram. These overlays assist 
in the counseling process. Select Tools > Options > Audiometry > Tone > Over-
lays to enable or disable displaying the overlays.

Click the Split view icon to select.
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– Pictures 
Displays pictures representing common environmental 
sounds at their approximate dB level (e.g. bird, plane).

– Severity 
Displays the audiometric severity levels (normal, mild, 
moderate, moderate-to-severe, severe, profound).

– Speech Banana 
Displays the speech banana of a listener with normal 
hearing. 

– Speech Letters 
Displays speech sounds at their approximate dB level.

– Unusable area 
Shades the area which is outside the patient's dynamic 
range of hearing.

– Default 
Returns the overlay options back to whatever has been 
set as default.
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The Speech test screen 

4.5.3 The Legend box

The Legend box shows the audiogram symbols used in the graphs.

4.6 The Speech test screen
During online testing, the screen reflects the test done by the audiometer as it 
progresses. 

4.6.1 The work area in the Speech screen

The speech test results of the selected Client are shown automatically in the stimulus 
bar.

You can choose between 

Tabular view

Audiogram

Work area

Stimulus bar

• tabular view. See Fig. 9  49.

• graph view. See Fig. 10  50.
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The Speech test screen

Speech testing - tabular view

Fig. 9 Speech testing - tabular view

The Speech Table displays the scores for right, binaural and left ear data collection. 

During testing, the word count results are shown automatically.

• Entering results in Score tables 
To enter the results in the Score tables, simply left-click in the required field.

• Deleting results in Score tables 
To delete specific results in the Score tables, simply right-click in the required 
field and select Delete.

• Storing results in Score tables 
To store results in the Score tables, simply right-click in the required field and 
select Store.

• PTA field 
To select the frequencies from which the average is to be calculated, select Tools 
- Options - Audiometry - General - PTA Frequency, and enter your selections.

Level LevelLevel

Score Level Score LevelScore Level

Left Right
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The Speech test screen 

Speech testing - graph view

Fig. 10 Speech testing - graph view

The Speech Graph screen displays the speech graph which includes SDT, SRT, MCL, 
UCL noted by a line (blue = left, red = right) at the corresponding dB level.  

Symbols will be shown based on the location corresponding to the dB level of pres-
entation and the percentage of correct responses.

4.6.2 The Legend box

The Legend box shows the audiogram symbols used in the graphs.

4.6.3 Terms and abbreviations used in Speech testing

SDT Speech Detection Threshold

SRT Speech Recognition Threshold

MCL Most Comfortable Level, speech

UCL UnComfortable Level, speech

WRS/SRS Word Recognition Score/Sentence Recognition Score

Can store up to 4 lines of WRS/SRS scores. An additional line 
appears (max 4) when you change settings (level, speech material, 
etc).

• Score 
Percentage of correct/incorrect words.
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The Aided Speech test screen

4.7 The Aided Speech test screen
This screen is for testing clients with hearing instruments.

For a description of the screen and its functionalities, see 4.6 The Speech test 
screen  48.

4.8 The Patient Responder indicator
When the patient presses the Patient Responder, this is shown on the Stimulus bar, 
and a "beep" from the PC is heard through the Monitor Speaker or Operator Head-
set.

Single Responder setup
• Amber 

Indicates that the patient is pressing the response button.

Dual Responder setup
If separation is activated when the patient presses the Patient Responder button, a 
response indication coloured Red or Blue is shown, depending on the button pressed.

If separation is not activated when the patient presses the Patient Responder button, 
then either button will show the same response indication (Amber).

• Level 
dB level at which the words were presented.

• Noise 
dB level of masking. The masking stimulus is considered 
noise if it is presented into the contralateral (opposite) ear in 
relation to the stimulus ear.

• SNR 
Signal-to-Noise Ratio calculated as the difference between 
the dB of the stimulus and the dB of the masking. The SNR 
is only calculated if the masking signal is in the ipsilateral 
(same) ear in relation to the stimulus ear.

PTA Pure Tone Average
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Curves and symbols selection 

• Red 
Indicates that the patient is pressing the right response button.

• Blue 
Indicates that the patient is pressing the left response button.

• Red and blue 
Indicates that the patient is pressing both response buttons.

4.9 Curves and symbols selection

4.9.1 Selecting a symbol or curve

You can select a symbol and/or a curve style for a specific measurement. 

1. To do so, select Tools > Curves and Symbols... 
2. Click on the selections that apply to your measurement under Test, Transducer, 

and Aided Condition. The current symbols and line style are shown.
3. Double-click on the symbol you wish to change. The Symbols selection dialog 

box is shown.
4. Double-click on the symbol you wish to use.
5. To change the line style of the curve, select from the Line Style drop-down list.
6. To change the color, double-click on the current Color square. Select a new color 

or click on Define custom colors>> to select a color not shown. Click OK.
7. To optimize viewing of the audiogram, you can offset the symbols in relation to 

the audiogram grid in the fields Horizontal Offset and Vertical Offset.
You can superimpose symbols on the audiogram where two different points 
share the same value (i.e. air and bone threshold). In order to see both superim-
posed symbols, you can define an offset direction for each individual symbol.
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Curves and symbols selection

4.9.2 Creating new symbols

1. Use Microsoft Powerpoint to create vector graphics that you save as Enhanced 
Meta Files (*.emf). 
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The Masking Assistant 

2. The outer size of the EMF file must not be larger than or equal to 1 x 1 inches 
(2.5 x 2.5 cm).

Note · If the symbols are created larger than that, this may severely compromise the per-
formance of OTOsuite. 

The standard symbols are drawn within a centered inner frame of 1.5 x 1.5 cm 
(0.6 x 0.6 inches). 

The area between the inner and outer frames is used for additions to the main 
symbol, such as arrows for "No Response" or "Response at Limit", and designa-
tors for "Aided Left" or "Aided Right".

3. Before you store the new graphic, make sure that the outer and inner frames are 
invisible: select the frame, and set the line color to "No Line". Repeat this for 
each frame. 

4. To save as an *.emf picture file, select all elements in the drawing (typically this 
includes the invisible outer frame as well as the symbol itself centered within the 
frame). Right-click and select Save as picture... 

5. Name the figure and select the file type *.emf. 
6. Save it in C:\Program Files\GN Otometrics\OTOsuite\AudSymbols.
7. Launch the OTOsuite Audiometry Software Module and go to Tools > Curves 

and Symbols. The new symbol should appear on the list of symbol options. 
In this dialog box, you also have options for setting the color, line type, and hor-
izontal and vertical offsets that will apply when you use the new symbol.

4.10 The Masking Assistant
If the Masking Assistant is enabled, it will at all times check for frequencies that may 
require testing with masking. This also applies to old audiograms imported from 
NOAH or XML as long as a supported transducer was stored with the data.

The Masking Assistant is a tool provided to help you with an indication that there 
may be frequencies where testing with masking[1] is recommended. 

• The audiogram symbol will flash at the specific frequencies where contralateral 
masking may be recommended[2].

[1]  (Katz, J., Lezynski, J. (2002). Clinical Masking. In J. Katz, ed., Handbook of Clinical Audiology, Williams and 
Wilkins, Baltimore.)

[2] Based on criteria described in Clinical Masking, Essentials of Audiology, Stanley A. Gelfand, Thieme 1997, and 
Measurement of Pure Tone Hearing Thresholds, Audiologists’ Desk Reference - Vol 1, James W. Hall III, H. Gus-
tav Mueller III, Singular Publishing Group 1997. and Munro K.J., Agnew N. A comparison of inter-aural atten-
uation with the Etymotic ER-3A insert earphone and the Telephonics TDH-39 supra-aural earphone. Br J Audiol 
1999; 33: 259-262.
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• The bone conduction masking criterion is configurable (0 - 15 dB air-bone gap). 
Select Tools > Options > Tone > Masking Assistant > BC Masking Criterion.

Only stored thresholds measured without masking are checked. Levels which did not 
evoke a response are excluded from the check. This means that as soon as a masked 
threshold has been stored, the flashing stops for that frequency.

Terminology

When is masking required?
Masking is recommended when the following conditions are met:

* denotes configurable Air/Bone gap criterion (Tools > Options... > Audiometry > 
Tone > Masking assistant > BC Masking Criterion).

Min IA is frequency specific
These are the Min IA tables for TDH-39 and Otometrics Inserts used in the Masking 
Assistant [1].

Min IA (Supraaural Phone: TDH-39), frequency specific

AC AC test ear

ACc AC contra

BC BC

BCc BC contra

Min IA Minimum inter-aural attenuation.

AC: AC > ACc + Min IA 

or AC > BCc + Min IA

BC: BC < AC - x* dB

[1] Katz, J., Lezynski, J. (2002). Clinical Masking. In J. Katz, ed., Handbook of Clinical Audiology, Williams and 
Wilkins, Baltimore. Munro, K.J., Agnew, N. A comparison of inter-aural attenuation with the Etymotic ER-3A 
insert earphone and the Telephonics TDH-39 supra-aural earphone. Br J Audiol 1999; 33: 259-262. Hall, JW., 
MUELLER, HG. (1997). The audiologists’ desk reference, Volume I., Singular Publishing Group, San Diego.

Hz TDH-39

125 35 Katz & Lezynski, (2002)

250 48 Munro & Agnew, BJA (1999)

500 44 Munro & Agnew, BJA (1999)
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Min IA (Insert Phone: EAR-3A)

750 40 N/A - fulfill traditional approach

1000 48 Munro & Agnew, BJA (1999)

1500 40 N/A - fulfill traditional approach

2000 44 Munro & Agnew, BJA (1999)

3000 56 Hall J.W. III & Mueller G.H. III / Munro & Agnew, 
BJA (1999)

4000 50 Katz J / Munro & Agnew, BJA (1999)

6000 44 Hall J.W. III & Mueller G.H. III / Munro & Agnew, 
BJA (1999)

8000 42 Katz J / Munro & Agnew, BJA (1999)

Hz EAR-3A

125 60 N/A - traditional value

250 72 Munro & Agnew, BJA (1999)

500 64 Munro & Agnew, BJA (1999)

750 60 N/A - traditional value

1000 58 Munro & Agnew, BJA (1999)

1500 60 N/A - traditional value

2000 56 Munro & Agnew, BJA (1999)

3000 58 Munro & Agnew, BJA (1999)

4000 72 Munro & Agnew, BJA (1999)

6000 54 Munro & Agnew, BJA (1999)

8000 62 Munro & Agnew, BJA (1999)

Hz TDH-39
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5 Preparing MADSEN Itera II for the test

To save time it is recommended that you have set up the test environment and equip-
ment before you prepare the patient. 

5.1 Preparing the test environment
It is recommended that you carry out testing in a test environment, such as a sound 
booth, protected from excessive noise produced for instance by office machinery and 
conversation. 

5.1.1 Hygienic precautions

• Be sure to follow any established infection control procedures for the setting in 
which you are working.

• Always use clean eartips.
• Swab the probe tip with disinfectant between ears. If one ear is infected, test the 

healthy ear first and change eartips between ears.
• To prevent cross-infection, use a clean eartip when you test the next patient.

5.2 Preparing the test equipment
1. Make sure that you have connected the required accessories:

– headphones. To connect, see 13.2.2 Air conduction  128.
– insert phone(s). To connect, see 13.2.2 Air conduction  128.
– bone conductor. To connect, see 13.2.3 Bone conduction  128.
– external microphone. To connect, see 13.2.4 External microphone  129.
– free field equipment. To connect, see 13.2.5 Free Field  130.
– patient response switch (3.3 Socket connections - rear panel  31).

5.2.1 Connecting the cables of the test equipment

Connect the cabling of the computer and various accessories as shown in the follow-
ing illustrations. 
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Fig. 11 USB/RS232 connection for PC or Laptop with USB port or RS232 cable for PC or Laptop 
with serial port

5.2.2 The patient response switch

• Place the patient facing away from the Itera II, in a sound booth, if one is availa-
ble. 

• Instruct the patient in how to use the Patient Response switch.
• Instruct the patient in pressing the button even if only weak signals are heard. 

Note · During automatic testing, if the patient presses the switch repeatedly during a 
stimulus presentation, the response is ignored.

Note · During automatic testing, if the patient does not release the switch, a beep is 
issued in the headphones. If this situation is repeated, the test is paused. Reinstruct the 
patient.

• Before testing, check that the Response indicator lights up when the Patient 
Response button is pressed.

5.2.3 Preparing for air conduction testing

Headphones, insert phones
Make sure that the headphones and insert phone(s) are properly connected.

Connection to Itera II
See 13.2 Installation  127 for a description of how to connect to Itera II. 

Fitting on patient
• Place the patient facing away from Itera II, in a sound booth, if one is available. 

Patient response switch
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Preparing the test equipment

• Set the switch on the Talk Back microphone to ON and set the level of Talk 
Back (3.2.5 The MIC, CD and REVERSE column  23).

• Fit the headphones on the patient, with the RED phone on the right ear.
• Choose the ear with the better hearing to be tested first.

Instructing the patient
• The patient will be hearing brief tones.
• The tones may at times appear to be very weak.
• Instruct the patient in how to use the Patient Response switch (5.2.2 The patient 

response switch  60).
• The patient should press the Patient Response switch as soon as the tone is 

heard, even if it is very weak. 

5.2.4 Preparing for bone conduction testing

Connection to Itera II
Make sure that the bone conductor is properly connected. See 13.2.3 Bone 
conduction  128. 

Fitting on patient
When you fit the bone conductor on the patient:
• Instruct the patient in what you are about to do. 

Note · The bone conductor cable and insert phone (E-A-RTONE® 3A) cable must not 
be removed or tampered with while Itera II is powered on. Either disconnect the bone con-
ductor entirely from the instrument, or make sure that the instrument itself is disconnected 
from the power source.

• If a sound booth is not available, place the patient facing away from Itera II. This 
is to avoid visual clues during testing.

• If applicable, set the switch on the Talk Back microphone to ON and set the 
level of Talk Back (3.2.16 The SETUP button  27).

• Position the bone conductor/vibrator so that it rests comfortably against the 
mastoid bone (behind the ear) and is not in contact with the pinna, or against 
the patient’s forehead.

• If Itera II is calibrated for this, see SETUP,  4 BC TRANSDUCER  102 to 
choose between Forehead and Mastoid, depending on the preferred placement of 
the bone conductor.

• Testing with masking 
If you intend to use masking, either use the mono insert phone (recommended) 
or fit the headphones so that the red (right) phone is applied to the poorer ear 
for masking, and the other phone is applied to the patient's temple region, leav-
ing the test ear uncovered. 
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Important · The masking transducer must not under any circumstances block or cover 
the bone conduction test ear. If it does, this will invalidate the test due to the occlusion 
effect.

Make sure that there is no contact between the headband, which holds the Bone 
Conductor in place, and the headset or headband supporting the headphones. 
This will prevent vibrations from being conducted from one to the other. Leave 
it in this position until the test is finished.

Instructing the patient
• The patient will be hearing brief tones.
• The tones may at times appear to be very weak.
• The tones can be heard either in the one ear, in the other ear or in both ears 

simultaneously.
• Instruct the patient in how to use the Patient Response switch (5.2.2 The patient 

response switch  60).
• The patient should press the Patient Response switch as soon as the tone is 

heard, even if it is very weak. 
• You may prefer that the patient indicates in which ear the tone was heard by rais-

ing a hand.
• The patient should not touch or move the bone conductor from its position.

5.2.5 Preparing for testing with masking

See 6.3.2 Air conduction with masking  72 for a recommended procedure on test-
ing with masking.

Instructing the patient
• In addition to the tones in the test ear, the patient will be hearing a noise in the 

other ear.
• The tones can be heard in either ear.
• The patient should respond to the tones in the test ear and ignore the noise.
• The patient should press the patient response switch as soon as the tone is heard. 
• You may prefer that the patient indicates in which ear the tone was heard by rais-

ing a hand. This is particularly relevant since masked testing is used to determine 
that the signal is perceived by the test ear.

5.3 Free-field

Connection to Itera II
See 13.2.5 Free Field  130 for a description of how to connect to Itera II. 
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Preparing the Audiometry Module for testing

5.4 Preparing the Audiometry Module for testing
1. Prepare the audiometer for the test. See the appropriate audiometer manual.
2. Follow the instructions in the OTOsuite User Manual:

– Start up OTOsuite and the test device.
– Select/create a client in OTOsuite.
– Select the test type in OTOsuite.
– Activate the Control Panel in OTOsuite.
– Select the test ear in OTOsuite.

Fetch multiple test results
• If you have done off-line testing with MADSEN Itera II, you can fetch test 

results from the audiometer. See 5.5 Fetch test results from audiometer  63.

5.5 Fetch test results from audiometer
To transfer test results from your audiometer:
• Switch on the audiometer.
• Select Tools > Fetch Test Results...

Follow the online instructions.

5.6 Preparing the patient for testing

Previous exposure to high levels of sound
If the patient has been exposed to high levels of sound, this may create a temporary 
threshold shift (TTS), which will diminish with time. If the patient is tested soon 
after this type of noise exposure, it may not be possible to determine the normal hear-
ing threshold. It is recommended that a minimum of 16 hours should pass between 
exposure and testing.

Explaining the test procedure
• Explain how the test will be done, including which ear will be tested first.
• Describe what the presented signals may sound like.
• Explain what the patient will be expected to do. This includes using the Patient 

Response Switch and responding to the presented signals/speech.
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6 Tone Testing with MADSEN Itera II 

6.1 Air Conduction threshold test
Modified (ascending) Hughson-Westlake.

6.1.1 Prerequisites

• Press TONE.
• Press AC.
• If required, select another stimulus type: WARBLE or PULSE (an advantage 

when you test children).
• If you want to use a predefined duration of the signal presentation when you 

press the INT button, press IMPULSE. 
• If masking is required, select the appropriate masking type: Press MASK ON. See 

also 6.3 Testing with masking  69.
• If required, turn the FREQUENCY knob to set the starting frequency: Typical 

starting frequency: 1000 Hz.
The signal is usually presented for each tone in the following order:

1000 Hz and increasing frequencies 
followed by  
1000 Hz (cross check) and decreasing frequencies.

• Set the initial level of the presented signal to an audible level: Turn the LEVEL 
knob to 40 dB HL.
This is to familiarize the patient with the test signal. Other familiarization proce-
dures may be preferred.

• Test the better ear first. If this is unknown, start with the right ear. Press L<-->R 
to select the ear you wish to test.

• Give the Patient Response switch to the patient and explain how it should be 
operated (see 5.2.2 The patient response switch  60).

6.1.2 Testing

1. Press the INT button (right or left) to present the tone to the patient for 1 to 1.5 
seconds.
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Air Conduction threshold test 

2. Use the corresponding LEVEL knob to set the intensity to approx. 20 dB above 
the patient's presumed threshold.
If the patient does not respond to the presented signal, turn the LEVEL knob to 
increase the signal level in steps of 10 dB until the patient responds.

3. Reduce the signal level by 20 dB until the patient does not respond to the signal.
4. Increase the signal level in steps of 5 dB and present the signal to the patient at 

each level until the patient responds to the signal.
5. Reduce the signal level by 10 dB and present signals at levels increased by 5 dB 

until the patient responds.
6. Repeat item 5, 1 to 3 times until the patient has responded 3 times at the same 

level. 
This level represents the hearing threshold at 1000 Hz based on 3-5 ascending 
series.

In some situations, it may be satisfactory with two responses at the same level.

If the patient has responded less than 3 times at the same level after 5 series, 
present a signal at 10 dB above the level where a response was last registered.

Then repeat item 6.

7. When the threshold is determined, press STORE to store that particular thresh-
old. See 3.2.13 The STORE button  26.

8. Select the next frequency.
You can link the Store and Next Frequency functions, so that the test progresses 
with the next frequency when you press STORE. See  13 FREQ.CH.AT 
STORE  104.

9. Continue to use the right and/or left LEVEL knob to increase/decrease intensities 
until you have determined all thresholds.  

Note · If the thresholds measured at 1000 Hz in the ear differ by 10 dB or more, even 
the other frequencies should be retested.

10.Continue to press STORE after each threshold is found to store that particular 
threshold. 

11.After each threshold is determined and stored, you will notice that as you turn 
the LEVEL knob to scroll frequencies, each stored threshold at that particular fre-
quency will be marked by an asterisk (*) and the relevant audiogram symbol 
indicating the stored threshold. 

12.If you are not performing the test online with the OTOsuite Audiometry Mod-
ule, plot the results in an audiogram sheet.
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13.Repeat this procedure for the other ear. 

Note · If there are differences between the thresholds in the two ears, see 6.3 Testing with 
masking  69.

6.1.3 Sound Field testing

When you select SF transducer and Free Field speakers (F.F.) are assigned as transduc-
ers (SETUP,  5 SF TRANSDUCER  103), the results are stored as an individual 
threshold curve using the applicable Sound Field symbols (3.1 Display  17).

The symbol used for Sound Field applies to both ears, unless masking has been used.

Tip:
If ear-specific data is retrieved by blocking the contra-lateral ear, activate the masking 
on the audiometer to use the correct symbols. This is especially important when you 
use Itera II with the OTOsuite Audiometry Module. 

Set the masking level to e.g. -10 dB, and note in the Comments field that the contra-
lateral ear was blocked.

6.2 Bone Conduction threshold test

Note · In Bone Conduction testing, masking is always necessary in order to determine 
in which ear the presented tone signal is actually heard. This is because of the reduced level 
of inter-aural attenuation.

Note · Make sure that there are no interfering ambient sounds, particularly at low fre-
quencies. If necessary, place the patient in a sound booth.

6.2.1 Prerequisites

• Press TONE.
• Press BC.
• If required, select another stimulus type: WARBLE or PULSE. 
• Press the REVERSE button to set the stimulus signal to continuous presentation 

(use full for placing the bone conductor correctly on the patient).
• Set the dB level to a level that will be heard clearly by the patient.
• Place the bone conductor on the patient. See 5.2.4 Preparing for bone conduc-

tion testing  61.
• Find the best position for the bone conductor. Ask the patient to report when 

the tone seems the loudest. 
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• Make sure that the bone conductor stays securely in place with no contact to the 
pinna.

• Give the Patient Response switch to the patient and explain how it should be 
operated (see 5.2.2 The patient response switch  60).

• Press REVERSE to deactivate the REVERSE function.
• If you want to use a predefined duration of the signal presentation when you 

press the INT button, press IMPULSE. 
• If masking is required, see 6.3 Testing with masking  69.
• If required, turn the FREQUENCY knob to set the starting frequency: Typical 

starting frequency: 1000 Hz.
The signal is usually presented for each tone in the following order:

1000 Hz and increasing frequencies, 
followed by frequencies below 1000 Hz in descending order.

The typical test frequencies are:

250 Hz to 4000 Hz.

• Set the initial level of the presented signal to an audible level: Turn the LEVEL 
knob to 40 dB HL.
This is to familiarize the patient with the test signal. Other familiarization proce-
dures may be preferred.

• If you intend to test both ears, test the better ear first. If this is unknown, start 
with the right ear. Press L<-->R to select the ear you wish to test.

6.2.2 Testing

1. Press the INT button (right or left) to present the tone to the patient for 1 to 1.5 
seconds.

2. If the patient does not respond to the presented signal, turn the LEVEL knob to 
increase the signal level in steps of 10 dB until the patient responds.

3. Reduce the signal level by 20 dB until the patient does not respond to the signal.
4. Increase the signal level in steps of 5 dB and present the signal to the patient at 

each level until the patient responds to the signal.
5. Reduce the signal level by 10 dB and present signals at levels increased by 5 dB 

until the patient responds.
6. Repeat item 5, 1 to 3 times until the patient has responded 3 times at the same 

level. 
This level represents the unmasked hearing threshold at 1000 Hz based on 3-5 
ascending series.

In some situations, it may be satisfactory with two responses at the same level.
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If the patient has responded less than 3 times at the same level after 5 series, 
present a signal at 10 dB above the level where a response was last registered.

Then repeat items 3 to 6.

7. When the threshold is determined, press STORE to store that particular thresh-
old. See 3.2.13 The STORE button  26.

8. Turn the FREQUENCY knob to select the next frequency. 

You can link the Store and Next Frequency functions, so that the test progresses 
with the next frequency when you press STORE. See  13 FREQ.CH.AT 
STORE  104.

9. Continue to use the right and/or left LEVEL knob to increase/decrease intensities 
until you have determined all thresholds. 

10.Continue to press STORE after each threshold is found to store that particular 
threshold. 

11.After each threshold is determined and stored, you will notice that as you turn 
the LEVEL knob to scroll frequencies, each stored threshold at that particular fre-
quency will be marked by an asterisk (*) and the relevant audiogram symbol 
indicating the stored threshold. 

12.If you are not performing the test online with the OTOsuite Audiometry Mod-
ule, plot the results in an audiogram sheet.

13.Repeat this procedure for the other ear. 

Note · If the difference between the air conducted threshold and the unmasked bone con-
duction threshold of the same ear is 15 dB or greater, it is recommended that you retest 
bone conduction thresholds with masking applied to the contralateral ear. See 6.3 Testing 
with masking  69.

6.3 Testing with masking
To prepare the patient for masking, see 5.2.5 Preparing for testing with 
masking  62.

6.3.1 When is masking required?

When to use masking for Air Conduction testing
If the difference between the thresholds in the two ears is 40 dB (TDH39), or 60 dB 
(EAR-3A), or greater, it is recommended that you test the poorer ear again with 
masking applied to the better ear. 
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If the appliance of masking is to be optimally administered without using unneces-
sary masking, it is recommended in the literature not to use the one-number-fits-all 
40 dB criterion for circum-aural and 55 to 60 dB criterion for insert phones. This 
may cause errors, and will increase the test time, as well as increase the strain on the 
patient. Instead, the literature recommends the use of frequency specific criteria that 
would be taken from transducer specific inter-aural attenuation tables available from 
clinical studies.[1] See also 

When to use masking for Bone Conduction testing
If the difference between the air conducted threshold and the unmasked bone con-
duction threshold of the same ear is 15 dB or greater, it is recommended that you 
retest bone conduction thresholds with masking applied to the contralateral ear. See 
6.3 Testing with masking  69.

When to use an insert phone
Masking via insert phone is recommended. The insert phone gives less inter-aural 
cross talk than the TDH39 headphones. 

• Use the insert phone instead of the TDH39 headphones for masking when you 
test the Bone Conduction threshold of patients with much more hearing loss in 
one ear than in the other. This will reduce the risk of over-masking caused by the 
high masking level required in the poorer ear. 
In order to use the insert phone for masking bone conduction, the EAR-3A 
must be included as a transducer for your audiometer. It will be available either 
as the standard AC transducer, or as an SF transducer. Make sure that it is 
selected in SETUP,  7 BC MASKING  103.

The test procedure is similar to that described in 6.3.3 Bone conduction with 
masking  73. 

Min IA is frequency specific
These are the Min IA tables for TDH-39 and EAR-3A that you can use to optimize 
the use of masking.

The numbers are rounded down to the closest 5 dB step.

Min IA TDH-39

[1]  (Katz, J., Lezynski, J. (2002). Clinical Masking. In J. Katz, ed., Handbook of Clinical Audiology, Williams and 
Wilkins, Baltimore.)

Hz dB Source

125 35 Katz & Lezynski, (2002)

250 48 Munro & Agnew, BJA (1999)
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Min IA EAR-3A

500 44 Munro & Agnew, BJA (1999)

750 40 N/A - traditional approach

1000 48 Munro & Agnew, BJA (1999)

1500 40 N/A - traditional approach

2000 44 Munro & Agnew, BJA (1999)

3000 56 Munro & Agnew, BJA (1999)

4000 50 Munro & Agnew, BJA (1999)

6000 44 Munro & Agnew, BJA (1999)

8000 42 Munro & Agnew, BJA (1999)

Hz dB Source

125 35 N/A - traditional approach

250 48 Munro & Agnew, BJA (1999)

500 44 Munro & Agnew, BJA (1999)

750 40 N/A - traditional approach

1000 48 Munro & Agnew, BJA (1999)

1500 40 N/A - traditional approach

2000 44 Munro & Agnew, BJA (1999)

3000 56 Munro & Agnew, BJA (1999)

4000 50 Munro & Agnew, BJA (1999)

6000 44 Munro & Agnew, BJA (1999)

8000 42 Munro & Agnew, BJA (1999)

Hz dB Source
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6.3.2 Air conduction with masking

Suggested procedure

Prerequisites
The unmasked hearing thresholds have first been determined as described in 6.1 Air 
Conduction threshold test  65.

Prerequisites as in 6.1 Air Conduction threshold test  65.

• Prepare the patient for testing with masking. See 5.2.5 Preparing for testing with 
masking  62.

• It is recommended to use the default setup used in connection with selecting 
MASK ON for presenting the masking signal as continuous presentation.
This means that you will not be using the INT button to control the masking sig-
nal.

Testing
1. Press MASK ON to activate contralateral masking.
2. Set the masking level at the threshold of the masking ear and make sure that it is 

heard by the patient. 

If it is not, increase the masking level.

3. Present the tone to the test ear at the unmasked threshold level.
If the tone is not heard, increase the level in 5 dB steps until the patient 
responds.

4. When the patient responds, increase the masking level in 5 dB steps. 

After each increase, present the tone no more than twice. The tone is considered 
heard if the patient responds at least once.

If the tone is heard when the masking level has been increased with at least three 
5 dB steps, the so called masking plateau has been reached and the test tone level 
is considered the masked hearing threshold level.

5. If the tone is not heard when the masking level is increased, increase the test tone 
level until the tone is heard by the patient.
Repeat from step 4.

6. If the test tone level at the masking plateau (established in step 4) is within 5 dB 
from the unmasked threshold level, you can skip step 7.

7. Keep the established masking level and confirm the masked hearing threshold 
level. To do so:
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Decrease the test tone level by 10 dB and increase in 5 dB steps.

The patient should respond within 5 dB from the previously determined masked 
threshold level.

If not, repeat from step 2.

8. If required, test the remaining frequencies in the same way and switch to the 
other ear.

6.3.3 Bone conduction with masking

Suggested procedure

Prerequisites
Prerequisites as in 6.2 Bone Conduction threshold test  67.

• Prepare the patient for testing with masking. See 5.2.5 Preparing for testing with 
masking  62.

• It is recommended to use the default setup used in connection with selecting 
MASK ON for presenting the masking signal as continuous presentation.
This means that you will not be using the INT button to control the masking sig-
nal.

Testing
1. Establish the unmasked bone threshold. If this has been done previously, and a 

different level is established in this step, do not overwrite the previously recorded 
threshold. The conditions may have changed if the masking transducers were 
placed following the first test (for example due to the occlusion effect).

2. Press MASK ON to activate masking.
3. Set the masking level at the air conduction threshold of the masking ear and 

make sure that it is heard by the patient. 

If it is not, increase the masking level.

4. Present the tone to the test ear at the previously confirmed unmasked bone con-
duction threshold level.
If the tone is not heard, increase the level in 5 dB steps until the patient 
responds.

5. When the patient responds, increase the masking level in 5 dB steps.
After each increase, present the tone no more than twice. The tone is considered 
heard if the patient responds at least once. 
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If the tone is heard when the masking level has been increased with at least three 
5 dB steps, the so called masking plateau has been reached and the test tone level 
is considered the masked hearing threshold level.

6. If the tone is not heard when the masking level is increased, increase the test tone 
level until the tone is heard by the patient. 

Repeat from step 5.

7. If the test tone level at the masking plateau (established in step 5) is within 5 dB 
from the unmasked threshold level, you can skip step 8.

8. Keep the established masking level and confirm the masked hearing threshold 
level. To do so: 

Decrease the test tone level by 10 dB and increase in 5 dB steps.

The patient should respond within 5 dB from the previously determined masked 
threshold level.

If not, repeat from 3.

9. If required, test the remaining frequencies in the same way and switch to the 
other ear.

6.4 Storing thresholds
To use the store button, see 3.2.13 The STORE button  26.

Results can be stored on a PC when Itera II is used with the OTOsuite Audiometry 
Module.
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7 Speech Audiometry with MADSEN Itera II

1. Prepare the patient for testing as described in 5 Preparing MADSEN Itera II for 
the test  59.

2. To select Speech testing press SPEECH. 
3. You can now proceed with:
• 7.1 Monaural Speech Test  75, or
• 7.2 Binaural Speech Test  78

7.1 Monaural Speech Test

1. When you select Speech Test, the display shows the following:
• the top line displays the VU meter for the test signal, 
• a speech counter to count the number of words heard by the patient correctly or 

incorrectly, and 
• indication of any masking signal.
• The intensity for left and right ear is shown on the bottom line.

7.1.1 Selecting input

Select Microphone or CD input by pressing the MIC. or CD button.

• MIC.  
If you press MIC., the microphone selection is shown briefly in the display, as fol-
lows: 

EXTERN MIC., or 
INTERN MIC.

The display then shows the selected microphone input for the current ear:

11
75

SPN
65L

|||||||||||
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MIC1 (default), or 
MIC2

You can set the sensitivity independently for MIC1 and MIC2 ( Adjusting input 
sensitivity  77), regardless of whether both MIC input channels are routed 
from: 

• a single microphone (the internal microphone, an external table-top microphone 
or an external monitor headset),
or from 

• two different external microphones (gooseneck microphones).
If you are using an Itera II with two built-in gooseneck microphones, the follow-
ing selections apply (gooseneck microphones are external microphones):

MIC1 = left gooseneck microphone 
MIC2 = right gooseneck microphone

Note · If you connect an external microphone, which can be the monitor headset or the 
gooseneck microphones, to EXTERN MIC, this automatically disables the internal micro-
phone (INTERN MIC.). If no external microphone is connected, the corresponding inter-
nal microphone will automatically be selected. 

• CD  
If you press CD, CD_1 or CD_2 is shown briefly in the display. 
The CD_1 input is Channel 1 (left) on the recording. 
The CD_2 input is Channel 2 (right) on the recording.

Switching between input signals
You can switch between input channels: 

• Press and hold MIC. or CD, and simultaneously press  
L <--> R. 
The display will show the input channel you have selected, and flashes as long as 
you keep pressing the button. 

You can also switch between all available inputs:

• Turn the frequency selector while you press MIC. or CD. 
In this case you get access to all possible microphone and CD options. If you 
select CD for one ear and the microphone for the other, both MIC and CD will 
light up.
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Monaural Speech Test

One-channel or two-channel testing
You can choose to operate Itera II as a one-channel or a two-channel speech audiom-
eter. To do so, select either the same input to both ears (one-channel) or select two 
different inputs (two-channel).

When you use two-channel testing, there are 16 possible combinations of inputs.

• Regular one-channel monoaural testing (default) 
CD_1 is the default input channel for right or left ears. Masking is available for 
the opposite ear.

• Two-channel monoaural testing 
This test requires special routing. See 7.3.1 Mixing input signals for two-channel 
monaural Speech  80.

Adjusting input sensitivity
You can adjust the strength of the input signal: 

1. Press and hold the selected input button and use the right LEVEL selector while 
you check the bar indicator at the bottom of the display.

2. Make sure that the speech signal is reproduced correctly with the dB value stated 
in the display: the VU meters must move into line with "0 dB" on the VU meter 
scale.

7.1.2 Selecting masking for speech audiometry

If you select masking, the masking signal is displayed in the first line of the display. 
You can select 

• Speech noise (SPN), or 
• White noise (Wide Band Noise - WBN).  

To adjust the masking signal type selection, select SETUP,  11 SPEECH MASK. 
SIG.  104.

75
SPN

65 RL

|||||||||||
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Binaural Speech Test 

7.1.3 The counter function in speech audiometry

There are three ways of counting words in a Speech test. To select the counting 
method, select SETUP,  12 SPEECH COUNT  104.

Use the right LEVEL selector to select the counting method.

1. OK Words (5-25) 
Press PASS to count words heard.

2. FAIL WORDS (5-25) 
Press FAIL to count unheard words.

3. OK & FAIL WORDS 
Here you can press both PASS and FAIL to count heard and unheard words with 
the advantage that you do not need to listen to the whole list of words, nor state 
the number of words in the list.

Selecting number of words in list
• Use the FREQUENCY selector to select the number of words (5 - 25) in the list.

Resetting the counter value
• If you change the dB level, the counter value will be reset for starting a new test. 

Important · Be careful not to change the dB level before you have made a note of the 
results. 

7.1.4 Interrupting the speech signal

• You can interrupt the speech signal by deactivating the REVERSE button.  

Note · There are no interrupt buttons in Speech mode, since they are used for counting 
words.

7.2 Binaural Speech Test
In Binaural Speech testing, a stimulus is presented to both ears. This may be as a sin-
gle signal (one-channel), or as two different signals (two-channel).

12
75

|||||||||||||
65L

|||||||||||
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Binaural Speech Test

• To perform a standard one-channel Binaural Speech test, select Speech Test and 
press twice on L <--> R. 
The input signal currently selected in monaural is also set as input on the oppo-
site side as default. 

This means that if the monaural input was the left CD input channel (CD_1), 
and binaural is selected by pressing L <--> R, then the left CD input channel 
(CD_1) is also assigned to the right ear:

To change the input channels, see 7.1.1 Selecting input  75.

7.2.1 One-channel or two-channel Speech testing

To select one or two input channels, see 7.1.1 Selecting input  75.

You can choose to operate Itera II as a one-channel or a two-channel Speech audiom-
eter. To do so, select either the same input to both ears (one-channel) or select two 
different inputs (two-channel).

• One-channel binaural testing (default) 
CD_1 is the default input channel for both ears. If you wish to use CD_2 for 
one-channel testing, you must change both input channels.

The stimulus level is interlocked and cannot be adjusted separately. 

Masking is available on the audiometer.

• Two-channel binaural testing 
Select two different input channels, one for each ear.

The stimulus levels can be adjusted independently.

Masking is available on the audiometer.

7.2.2 Adjusting input sensitivity

You can adjust the strength of the input signal:

CD_1
|||||||||||||
CD_1

|||||||||||
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1. Press and hold the selected input button and use the right LEVEL selector to 
adjust the strength of the input signal in the channel which is flashing on the dis-
play. 

2. Press L <--> R to toggle to the opposite input channel to be able to adjust its sen-
sitivity. To calibrate the speech signal, the VU meters must move into line with 
"0 dB" on the VU meter scale.

7.3 Special Speech routing

7.3.1 Mixing input signals for two-channel monaural Speech

Note · If masking noise is switched on, the input signals cannot be mixed (see 
7.3.3 Binaural Speech with masking  81).

If you press and hold CD or MIC and then press L <--> R, the selected test input 
source is sent to the left ear, indicated by an arrow from right to left.

• Press once more to send the input to the right ear.

• Press once more to send the input to each ear in the normal way. The arrow dis-
appears.

7.3.2 Speech in Noise

Adjusting the masking dB level
To adjust the masking dB level, use the LEVEL knob on the masking side to select.

CD_1
|||||||||||||
MIC2

|||||||||||

CD_1
|||||||||||||
MIC2

|||||||||||
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Special Speech routing

Switching masking noise to other ear
To toggle the masking noise to the other ear press L <--> R. This lets you switch the 
masking noise to the same side as the speech signal. 

An arrow appears, pointing to the ear to which the masking is to be presented.

Masking noise in both ears
To transmit the masking signal to both ears, press and hold MASK ON and then press 
twice on L <--> R. To disable this setting, press twice on L <--> R. 

When the masking signal returns to normal (contralateral) masking (i.e. when you 
press MASK OFF or press L <--> R), the arrow(s) disappears. 

Note · Binaural masking is not possible in BC testing.

7.3.3 Binaural Speech with masking

1. To switch on masking noise, press MASK ON. MASK LOCK cannot be selected. 
2. By default, masking noise is transmitted to both ears, but you can select the 

masking ear: press and hold MASK ON and press L <--> R once to send the mask-
ing noise to the left ear only.

• Press L <--> R once more to send the masking noise to the right ear only. This is 
how you switch between left and right ear.

• Press twice on L <--> R to send the masking noise to both ears.

0
75

SPN
65 RL

|||||||||||

75
|||||||||||||

7560 RL

|||||||||||

75
|||||||||||||

7560 RL

|||||||||||
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Special Speech routing 

7.3.4 Masking level for Binaural Speech

Turn the FREQUENCY knob to set the masking dB level.

For a description of how to test a patient and record an audiogram, see 6 Tone Test-
ing with MADSEN Itera II  65.

75
|||||||||||||

7560 RL

|||||||||||
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8 Special tests with MADSEN Itera II

1. Prepare the patient for testing as described in 5 Preparing MADSEN Itera II for 
the test  59.

2. If you press SPECIAL, the available special tests are shown in groups of three. To 
select the required test, press the relevant function key below the test name. If 
SPECIAL flashes, more tests are available. 

If Itera II features more than three special tests (depending on the software ver-
sion), press SPECIAL twice to see more tests. 

The three tests last used will always be displayed first when you press SPECIAL.

8.1 MCL tone testing
To test for MCL (Most Comfortable Level) using tones:

• Press SPECIAL one or more times, and press the appropriate function key to 
select. 

No masking – the stored value symbol is M (No response cannot be stored).

8.2 UCL tone testing
To test for UCL (UnComfortable Level) using tones:

• Press SPECIAL one or more times, and press the appropriate function key to 
select. 

No masking – the stored value symbol is U (No response cannot be stored).

8.3 SISI Test
The SISI (Short Increment Sensitivity Index) test consists of brief, random incre-
ments in intensity. 
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SISI Test 

The dB increments are presented randomly at intervals of 4 to 6 seconds, and the per-
mitted response time is 2 seconds.

1. Press SPECIAL one or more times until SISI appears and press the appropriate 
function key to select the test. The following display appears:

The top line shows the intensity (dB HL) to which the increments have been 
added, the test name, and the current SISI % score. 

The bottom line shows the number of dB increments currently transmitted, the 
test tone frequency and the scale of the SISI dB increments.

2. Set the number of increments for the test: 
Press SETUP once and use the right LEVEL knob.

3. To start the SISI test press the START/STOP button.  

The test stops automatically when the selected number of steps in intensity has 
been reached, and a beep is heard. 

Automatic scoring of responses
The percentage of correct responses (% score) is updated automatically.

Short increment indication
The presence of a short increment in intensity is indicated by the little L or R test ear 
indicator in the display changing momentarily to a rectangle, .

Scoring of responses
• The patient must use the Patient Response switch to register each increment that 

has been heard.
• Manual scoring 

If the patient is unable to use the Patient Response button, but registers an incre-
ment heard in another way, you can press PASS (right INT button) to indicate 
that the tone was heard.

Pausing the test
• You can pause the SISI test by pressing START/STOP again. During the pause 

"SISI" will flash in the display. To resume the test press START/STOP once more.

SISI
0

0%
0.251000 RL

20
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SISI Test

Aborting the test
• During a pause, you can stop the test completely by pressing ERASE. Select Yes to 

erase all SISI data and stop the test completely, or No to retain SISI data and 
resume the test. 

Restarting the test
• If you press ERASE when the test is in progress. Select Yes to erase data. The 

counter is reset to zero and the test will start again from the beginning. 

Changing the dB level
• To change the dB level use the left LEVEL knob. 

Changing the dB increments
• To change the dB increments use the right LEVEL knob (0.25 - 5dB). 

If you do so while the test is in progress, the counters are reset to zero and the 
test starts again from the beginning.

Changing number of increments
• To change the preset number of SISI dB increments transmitted during a test 

(10-50) press SETUP once and use the right LEVEL knob. Then press SETUP 
again to implement the new setting. While the SISI test is in progress, it is not 
possible to change the frequency or the number of dB increments.

8.3.1 Masking during SISI

Masking
• To perform masking, press MASK ON or LOCK. 

When you hold down the button, the masking intensity (instead of % score) and 
signal type are displayed. 

Intensity
• To change the intensity press and hold the button and turn the right LEVEL 

knob.

Signal type
• To change the signal type press and hold the button and turn the left LEVEL 

knob.

8.3.2 Using STORE in the SISI test

Note · A maximum of four different sets of SISI values can be stored for both left and 
right ear.

Storing results
• When the test is completed for a frequency, press STORE to store: 
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ABLB (Fowler) 

SISI % score, number of dB increments administered,  
dB increment, 
dB level for test signal and masking signal (if applicable).

An * symbol appears by the frequency and an x/o symbol for the left or right 
side. 

• Test the next frequency.

8.4 ABLB (Fowler)
In the ABLB (Alternate Binaural Loudness Balance) test, also known as the Fowler 
test, a tone is transmitted at the same frequency to the left and right ear alternately. 
The patient must decide when the same volume is achieved in both ears. The patient 
can indicate this by pressing the Patient Response switch.

1. To select the Fowler test press SPECIAL once or more until ABLB appears. 
2. Press ABLB once, and a display similar to the following will appear:

The top line shows the intensity for Right and Left channel and the test name. 

The frequency of the test tone and the rate of alternation from ear to ear and 
back again (the alternating frequency) appear on the bottom line.

Changing alternating frequency
To change the alternating frequency: 

1. Press SETUP once and use the right LEVEL knob (0.25 - 2.5 Hz). 
2. Press SETUP again to implement the new setting.
3. You can present the signal in two ways:

– present the signal to the patient by pressing the INT button, or
– press the REVERSE button to present the signal continuously. You can then 

interrupt the test signal by pressing the INT button.

xSISI
0

0%
0.251000L *

20

ABLB 15
2.25Hz1000 RL

20
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STENGER Test

Signal presentation (normal/REVERSE) follows the normal rules (see 3.2.23 Left 
INT button (FAIL)  31).

8.4.1 Using STORE in the ABLB (Fowler) test

Storing equal volume values
Press STORE to store values of  "equal volume". 

• You can store up to five sets of measurements for each test frequency. 
If you try to save more than five sets of measurements for a given frequency, Itera 
II displays the message "No more STORE". 

• You can store a maximum of four test frequencies, which you can select.
If you have stored two or more measurements at the same frequency, you can 
turn the frequency knob to step through each of these measurements in turn 
before changing to the next frequency.

Deleting individual measurements
• To delete an individual measurement press ERASE once while the measurement 

is displayed. Other measurements at the same frequency and at other frequencies 
remain unaffected.

If you change the signal type
If you start a test, and data are stored, you cannot just change the signal type. If you 
do so, the system will refuse to save data. The message "Not allowed" is displayed and 
the button(s) that has/have been wrongly set flash in the correct position (three short 
flashes).

Masking
Itera II cannot perform masking during an ABLB Test.

8.5 STENGER Test
The Stenger Test is used to reveal a unilateral non-organic hearing loss in one ear.

1. Before you perform a Stenger test, measure the patient's tone thresholds for the 
left and right ears. 

2. To select the Stenger test press SPECIAL (one or more times) until "STEN" 
appears. 

3. Select the test by pressing STEN once. The following display appears:
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A tone is transmitted at the same frequency on the left and right sides simultane-
ously. 

The display shows the signal selected as stimulus. This is either TON, WRB or 
NBN. To change the stimulus, see  Changing stimulus  88

4. Press either of the INT buttons to present the tone to the patient. 

Changing dB level
5. You can change the dB level setting separately for the right and the left ear: Set 

the dB level to 10 dB above the threshold in the better ear, and 10 dB below the 
threshold in the poorer ear. 

6. You can present the signal in two ways:
– present the signal to the patient by pressing the INT button, or
– press the REVERSE button to keep the signal continuous. You can then inter-

rupt the test signal by pressing the INT button.
Signal presentation (normal/REVERSE) follows the normal rules (see 3.2.23 Left 
INT button (FAIL)  31).

Changing stimulus
7. You can change the stimulus type from pure tone to Warble (WRB) or Narrow 

Band Noise (NBN). When you deactivate these stimulus types, the stimuli 
return to pure tone (TON). 
– Press WARBLE to activate or deactivate (see 3.2.4 The SIGNAL 

column  22);
– Activate Narrow Band Noise (to activate press MASK ON or MASK LOCK, to 

deactivate press MASK OFF). See 3.2.18 The MASK column  28.)
If you use the MASK LOCK function to select Narrow Band Noise, you lock 
together the L and R levels.

8.6 Hearing Instrument Simulation (HIS)
You can use this function to demonstrate how a hearing instrument will sound. 

Follow the steps described in 8.6.1 The HIS procedure  89.

STEN
TON

15
TON1000 RL

20
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Hearing Instrument Simulation (HIS)

A brief description
Itera II provides an immediate way to demonstrate what big help amplification can 
be. For this purpose, the basic simulation described below is quite sufficient in most 
cases.

The filter caracteristics are applied automatically in HIS, depending on the shape of 
the audiogram. The following is a description of the HIS approach:

1. High and low frequency filters are applied to match the slope of the audiogram.
2. The steepness of the audiogram slope in dB/octave is calculated, and the HIS is 

set to about half this approximated slope (according to half gain rule) using either 
6 dB (less steep slope), 12 dB (medium steep slope) or 18 dB (steep slope). 

3. The frequency where the most amplification is wanted (4 kHz is the highest 
available) is identified, and the cut-off frequency is set accordingly.

4. A gain is set to approximate half the hearing loss at the frequency selected in step 
3 (half gain rule again). 

5. Apply the simulation, and ask the patient whether it is comfortable or too loud 
or soft and adjust the reference level accordingly.

Make yourself familiar with the process before using it on the patient.

8.6.1 The HIS procedure

Connect accessories
• Connect the various accessories you will be using for the HIS test to Itera II.

Audiogram
• Use an audiogram stored in Itera II. 
or

• Enter an audiogram in Itera II. 

Prepare the patient
• Prepare the patient for the simulation, for instance by fitting headphones on the 

patient, and explain the process.

Select test
• Press SPECIAL (twice, if required) until HIS is shown on the display.
• Press the appropriate function key to select HIS.
• One of the following messages will appear:

Both calculated
HIS filters: OK
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Hearing Instrument Simulation (HIS) 

Sufficient audiograms are available for both ears

Sufficient audiogram is available for one ear only (in this case the Right ear).

Press Yes to copy the right audiogram to the left ear.

If you select No, in this example the Hearing Instrument Simulation will be 
made for the right ear only.

No sufficient audiograms are available. Enter the audiogram(s) manually or set 
the HIS filters manually (8.6.3 Manually adjusting the HIS filters  93).

• To continue, press either one of the INT buttons.

Adjust input sensitivity
• Adjust the input sensitivity (7.2.2 Adjusting input sensitivity  79).

Start the Hearing Instrument Simulation
• You are now ready to start the simulation.
• The default settings for the simulation are:

Transducer AC

Alternately SF 

Input MIC (live speech)

Alternately CD (7.2.1 One-channel or two-channel Speech 
testing  79) 

COPY R - > L ear ?
HIS filters : R OK

Missing data : L & R
HIS filters : None
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• To start the simulation, press START/STOP.

Adjust HIS reference level
• Adjust the HIS reference level. The level for normal speech considered for a per-

son with normal hearing is around 65 dB SPL. 
– Press SETUP once to view the Reference Level, for instance 65 dB. 
– To change this Reference Level for the HIS test, press SETUP once.
– The lower line of this display will show "Ref. 65 dB SPL", and from here you 

can change the setting to any level between 50 and 80 dB. To do so use the 
right LEVEL selector within three seconds.
This Reference Level is displayed in SPL. 

The effect of the HIS filters is to increase the level by their respective amplifi-
cation factors at low and high frequencies.

When the display shows "L 0 -HIS- 0 R", the zeros indicate that the hearing 
level corresponds to the Reference Level over the entire frequency range. To 
change this, see  Adjusting HIS "Master Volume"  92.

Muting the simulator
• If required, you can temporarily mute the output: Press REVERSE to deactivate 

the output (the button indicator turns off ). 
Both OUTPUT indicators light up automatically.

Simulating amplification
• The HIS always starts in unsimulated mode. The display shows  

-HIS- to indicate that the simulation filters are not activated. This means that the 
sound is presented without simulated amplification.

• Starting simulation
To start simulating, you must activate the HIS filters by pressing the 
START/STOP button. To show the benefit of a hearing instrument, use the 
START/STOP button to switch between simulating and not simulating the 
amplification.

• The display shows a + symbol for the ear where a simulation filter is activated.

HIS reference 
level

65 dB SPL 
The level for normal speech considered for a person with nor-
mal hearing is around 65 dB SPL.

Alternately:

See  Adjust HIS reference level  91
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Adjusting HIS "Master Volume"

Note · The system automatically sets the Master Volume.

• Increasing the output level manually
You can manually increase the output level by adding to the Reference Level. 

• Use the right and left LEVEL knobs to change the "Master Volume" as follows:
– The Master Volume for left and right ears are locked together as default. 

MASK LOCK is lit.
– Use the left or right LEVEL knob to control the "Master Volume" for both 

ears together. 
– If you wish to control the "Master Volume" for the two ears individually, 

press MASK LOCK to deactivate the locked function.

Example: 

Sound level =Ref. level + 10  = 65 + 10 = 75 dB SPL in both ears. 
None of the filters is active.

8.6.2 Viewing thresholds and filters

1. You can use the FREQUENCY knob to view stored thresholds and resulting fil-
ters graphically.

10
|||||||||||

10-HIS+ RL

||||||||||

No filter activated Filter activated

Master volume

10
|||||||||||

10-HIS- RL

||||||||||
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Note · The aspect ratio displayed is scaled, based on the audiogram thresholds listed at 
the beginning of this example.

TONE denotes AC  
BONE denotes BC 
HISF denotes Hearing Instrument Simulator Filter.

2. If the simulation is not satisfactory, use the manual procedure described in 
8.6.3 Manually adjusting the HIS filters  93 to further adjust.

8.6.3 Manually adjusting the HIS filters 

The filters are in series, but could theoretically still be set to simulate a three band 
hearing instrument by selecting different cut-off frequencies and adjusting the differ-
ent gains and the reference level.

Note · In the standard automatic HIS setup described in 8.6.1 The HIS 
procedure  89 this is done automatically.

To be able to change the HIS filter parameters for the left or right ear, press either the 
left or right INT button. This will display the filter characteristic for the selected ear 
as shown below:

The top line 
The top line shows the selected ear and shows whether the currently displayed param-
eters apply to the low pass (LP ) or high pass (HP ) filter. 

Right 55 |
TONE 10 | .....

.
...

Right 0 |
HISF 25 | . .

....
.

.... .

250Hz
LP

0db12s
LEFT EAR -

Second line

Top line
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The second line 
The second line shows the filter's 3 dB cut-off frequency, the filter slope (in dB per 
octave) and the (asymptotic) amplification at the filter cut-off frequency.

Changing values
The arrow points to a setting which you can change. To change a setting:

• Use the left LEVEL knob to move the arrow to the required setting.
• Use the right LEVEL knob to change the setting.

Moving the arrow also steps between the LP and HP filters. 

When you have set up the filter values, press the relevant INT button to return to the 
normal HIS screen.

You can press the START/STOP here, and the filters are updated online if you change 
a value while the filter is activated.

See • Starting simulation  91, and • Increasing the output level manually  92 to 
continue the procedure.

Filter examples
Any filter whose amplification is set to 0 dB has no effect. 

Parameter LP filter frequencies HP filter frequencies

Cut-off frequency 250, 500, 1000, 
2000 Hz

1000, 2000, 3000, 
4000 Hz

Slope 6, 12, 18 dB/octave 6, 12, 18 dB/octave

Gain above a selectable 
reference level

0, 5, 10, 15, 20, 25 dB 0, 5, 10, 15, 20, 25 dB
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Fig. 12 Low pass filter graph

Fig. 12  95 shows a graph where the characteristics of a low pass (bass) filter 
are set to an amplification of +20dB for frequencies under 250 Hz.

Fig. 13 High pass filter graph

Fig. 13  95 shows a graph where the characteristics of a high pass (treble) filter 
are set to an amplification of +25dB for frequencies over 2000 Hz.
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8.7 Overview of Monaural/Binaural Test signals and 
the Masking side

Fig. 14 Monaural/binaural test signals and masking side

Test signal Masking signal

Monaural Binaural Ipsi Contra

THR X X

SPEECH X X X X

SISI X X

ABLB X

STEN X

HIS X
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9 Managing Data and Results

9.1 Transferring test results from the audiometer to the PC
To transfer test results from your audiometer:
• Switch on the audiometer.
• In the OTOsuite Audiometry Module select Tools > Fetch Test Results...

Follow the onscreen instructions.

9.2 Storing data
You can store one set of AC data and one set of BC data, including thresholds for 
each frequency.

You can delete these thresholds one by one or collectively.

You can transfer these data to a pc with the OTOsuite Audiometry Module.

9.3 Printing results
Audiograms that have been saved in the OTOsuite Audiometry Module can be 
printed from the pc.
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Printing results 
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10 Setup of MADSEN Itera II Parameters

10.1 What does SETUP do?
You can define all of the Itera II's normal parameters and setups under SETUP. 

Permanent changes
You can change the parameters permanently and save them in a specific test setup of 
your choice

• 10.2.1 Permanent changes in the setup  99
•  1 SAVE TEST SETUP  102

Temporary changes
You can make temporary changes to the various parameters during a test. These 
changes will not be saved.

• 10.2.3 Temporary changes in the setup  100

10.2 How to use SETUP

10.2.1 Permanent changes in the setup

1. To access changing your parameters press twice on SETUP.  

When the SETUP function is active, the SETUP indicator light flashes. Most 
other buttons are deactivated and audiometry cannot be performed.

2. Turn the left LEVEL selector to select the parameter item you wish to change. 
When you select a new item, the item number is displayed briefly in the bottom 
line, for instance:

Item 5 

As a rule, the top line in the display contains a description of the current param-
eter, for instance:

SF TRANSDUCER 
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How to use SETUP 

The bottom line contains the value that you can change. The values available are 
shown one line at a time, for instance:

----   (None) 
HDA 200 
TDH39 
EAR-T. (E-A-R-TONE® 3A) 
F.F. 

3. To change the actual parameter value, for most items, use the right LEVEL selec-
tor. 

4. Changes made under SETUP will be saved when you leave SETUP, and will 
apply the next time Itera II is switched on. 

5. The most recently selected item will also be the one displayed the next time you 
activate SETUP.

6. To exit this function press twice on SETUP. 

10.2.2 Return to default settings

To return to the default settings, see  38 DEFAULT SETTING  112.

10.2.3 Temporary changes in the setup

ShortCuts
ShortCut is a faster way to access some of the parameters. Changes made to parame-
ters via ShortCut will not be saved when Itera II is switched off. 

•  Warble frequency  22
•  Warble modulation  22
•  Pulse frequency  22
•  Test signal duration  22
•  Input signal sensitivity, MIC/CD  23
•  Output level, headphone  25
•  Fixed dB level, talkover level  25
•  MIC sensitivity  25
•  Talkover signal to headphone  25
•  Setup - volume  28
•  Masking transducer selection  29
•  Masking noise in Speech  29
•  Display graphs, HIS mode  29
•  Warble modulation  30
•  Signal type, SISI  30
•  Master volume, HIS  30
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•  Parameter selection, SETUP  30
•  Talkback level  30
•  Warble modulation, amplitude  30
•  Pulse frequency  30
•  Impulse time  30
•  Input sensitivity, speech  31
•  Word counting method, speech  31
•  Alternating Fowler frequency  31
•  Master volume, HIS  31
•  Parameter selection, SETUP  31
•  Power out voltage  31

10.3 SETUP items

SETUP items:
 1 SAVE TEST SETUP  102 
 2 SET DEF. TEST P.  102 
 3 AC TRANSDUCER  102 
 4 BC TRANSDUCER  102 
 5 SF TRANSDUCER  103 
 6 AC MASKING  103 
 7 BC MASKING  103 
 8 SF MASKING  103 
 9 MASK. PRESENT.  103 
 10 TONE MASK. SIG.  104

 11 SPEECH MASK. SIG.  104 
 12 SPEECH COUNT  104 
 13 FREQ.CH.AT STORE  104 
 14 DB LEV. NEW TRA.  106 
 15 DB LEV. NEW FREQ  106 
 16 PULSE FREQUENCY  108 
 17 IMPULSE LENGTH  108 
 18 WARBLE MOD. SIZE  108 
 19 WARBLE FREQUENCY  109 
 20 SELECT AC FREQ.  109

 21 SELECT BC FREQ.  109 
 22 SIGNAL UNIT  109 
 23 MIC INPUT SENSE  109 
 24 CD INPUT SENSE  109 
 25 TALK OVER  110 
 26 TALK BACK MIC.  110 
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 27 MONITOR ON/OFF  110 
 28 MONITOR LEFT  110 
 29 MONITOR RIGHT  110 
 30 LIGHT INTENSITY  110

 31 INTERNAL BEEP  110 
 32 EXT. RANGE  111 
 33 EXT.R. dB-SPACE  111 
 34 BAUDRATE  111 
 35 CD POWER SUPPLY  111 
 36 DISPLAY  111 
 37 STIMULI KNOB  112 
 38 DEFAULT SETTING  112

Save test setup 1 SAVE TEST SETUP
Here you can save a test setup, e.g. masking ON, signal type WARBLE and pres-
entation REVERSE, so that this setup is used next time the device is switched 
on. This can be saved, and when the device is next switched on, these settings 
will be selected automatically. To use this item, press STORE.

Note · When Itera II is switched on and you choose between various tests, the Itera II 
will always revert to the setup last used for a given test.

Set default test parameters 2 SET DEF. TEST P.
Activates Itera II's default setting for the relevant test. All settings are set to the 
"default" values; for example, for the THR test the setting will be as follows: sig-
nal="TONE", mask="OFF", dB="5", etc.

If this setting is to apply next time Itera II is switched on, go to  38 DEFAULT 
SETTING  112 afterwards. To use this item, press STORE.

AC transducer 3 AC TRANSDUCER
Choose between calibrated headphones

----   (None)  
HDA 200 
TDH 39 
EAR-T. (E-A-R-TONE® 3A)

Note · If the wrong headphone is selected compared to the one that is physically connected 
to Itera II, the measurements will be incorrect!

BC transducer 4 BC TRANSDUCER
Choose between calibrated bone conductors:
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---- (None)  
B-71M (Mastoid)  
B-71F (Forehead) 

SF transducer 5 SF TRANSDUCER
Choose between calibrated headphones/free-field loudspeakers:

----   (None) 
HDA 200 
TDH39 
EAR-T. (E-A-R-TONE® 3A) 
F.F.

AC masking 6 AC MASKING
Select masking transducer for AC:

----  (None) 
AC TRANSDUCER 
BC TRANSDUCER 
SF TRANSDUCER

BC masking 7 BC MASKING
Select masking transducer for BC

----  (None) 
AC TRANSDUCER 
SF TRANSDUCER

SF masking 8 SF MASKING
Select masking transducer for SF

----  (None) 
AC TRANSDUCER 
BC TRANSDUCER 
SF TRANSDUCER

Masking presentation 9 MASK. PRESENT.
Set mode for masking interrupter:

CONTINUOUS • The masking signal is always present
FREE NORMAL • The masking signal follows the right interrupter 

- present when button is pressed.
FREE INVERSE • The masking signal follows the right interrupter 

- disappears when button is pressed.
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Tone masking signal 10 TONE MASK. SIG.
Select masking stimulus for Tone Test

NBN 
WBN

Speech masking signal 11 SPEECH MASK. SIG.
Select masking stimulus for Speech Test

SPN 
WBN

Speech count 12 SPEECH COUNT
Select number of words in a list, and select counting method. For further details, 
look under speech audiometry in 7 Speech Audiometry with MADSEN Itera 
II  75. 

OK & FAIL WORDS 
FAIL WORDS (5-25) 
OK WORDS(5-25)

Frequency change at 
STORE

13 FREQ.CH.AT STORE
Method for frequency change when you press STORE.

NO CHANGE (the frequency remains the same) 
If this parameter is set to “No change”, the setting will remain for instance at 
40 dB at 1000 Hz when you press STORE. See the following example.

WRAPIf you press STORE at the highest possible frequency, you switch to the 
lowest possible frequency. At other frequencies, pressing STORE advances the 
frequency. See the following example.

LOCKED NORMAL • The masking signal follows the right and left 
interrupter -present when button is pressed.

LOCKED INVERSE • The masking signal follows the right and left 
interrupter - disappears when button is pressed.

dB Hz

40 1000 Press STORE...

...continues at 40 1000
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BUTTERFLYIf you press the STORE button at the highest or the lowest possible 
frequency, you change to 1000 Hz.

Itera II will automatically test frequencies above 1000 Hz in ascending order, 
and frequencies below 1000 Hz in descending order. See the following example. 

dB Hz

40 1000 Press STORE...

...continues at 40 1500 Press STORE...

...continues at 40 2000 Press STORE...

...continues at 40 3000 Press STORE...

...continues at 40 4000 Press STORE...

...continues at 40 6000 Press STORE...

...continues at 40 8000 Press STORE...

...continues at 40 12500 Press STORE...

...continues at 40 125 Press STORE...

...continues at 40 250 Press STORE...

...continues at 40 500 Press STORE...

...continues at 40 750 Press STORE...

...continues at 40 1000

dB Hz

40 1000 Press STORE...

...continues at 40 1500 Press STORE...

...continues at 40 2000 Press STORE...

...continues at 40 3000 Press STORE...

...continues at 40 4000 Press STORE...

...continues at 40 6000 Press STORE...

...continues at 40 8000 Press STORE...

...continues at 40 12500 Press STORE...
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dB level new transducer 14 DB LEV. NEW TRA.
Choice of initial volume level for a new transducer, or change between different 
tests.

NO CHANGE or adjustable in the range: -10 to 50 dB 

dB level new frequency 15 DB LEV. NEW FREQ
Choice of initial intensity when changing frequency.

NO CHANGE (the frequency remains the same) 
or adjustable in the range -10 to 50 dB.  
See the example (with setting 13 set to WRAP):

...continues at 40 1000 Press STORE...

...continues at 40 750 Press STORE...

...continues at 40 500 Press STORE...

...continues at 40 250 Press STORE...

...continues at 40 125 Press STORE...

...continues at 40 1000 Press STORE...

...continues at 40 1500 Press STORE...

dB Hz

dB Hz

40 1000 Press STORE...

...continues at 40 1500 Press STORE...

...continues at 40 2000 Press STORE...

...continues at 40 3000 Press STORE...

...continues at 40 4000 Press STORE...

...continues at 40 6000 Press STORE...

...continues at 40 8000 Press STORE...

...continues at 40 12500 Press STORE...

...continues at 40 125 Press STORE...

...continues at 40 250 Press STORE...
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XX dB FIXED  
New fixed value.  
See the example (with setting 13 set to WRAP):

XX dB ABOVE THR  
New fixed value above any previously located threshold value. 
See the example (with setting 13 set to WRAP)

...continues at 40 500 Press STORE...

...continues at 40 750 Press STORE...

...continues at 40 1000

dB Hz

40 1000 Press STORE...

...continues at -10 1500 Press STORE...

...continues at -10 2000 Press STORE...

...continues at -10 3000 Press STORE...

...continues at -10 4000 Press STORE...

...continues at -10 6000 Press STORE...

...continues at -10 8000 Press STORE...

...continues at -10 12500 Press STORE...

...continues at -10 125 Press STORE...

...continues at -10 250 Press STORE...

...continues at -10 500 Press STORE...

...continues at -10 750 Press STORE...

...continues at -10 1000

dB Hz

40 1000 Press STORE...

...continues at 30 1500 Press STORE...

...continues at 20 2000 Press STORE...

dB Hz
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With masking

Pulse frequency 16 PULSE FREQUENCY
Choice of pulse frequency: 
0.25 to 2.50 Hz

Impulse length 17 IMPULSE LENGTH
Selection of the fixed period of time during which the signal will be presented 
when IMPULSE mode is selected. 
0.25 to 2.50 sec.

Warble modulation size 18 WARBLE MOD. SIZE
Set modulation size as a %:

1 to 25% e.g.: At 5% the signal modulates 5% in relation to default frequency

...continues at 10 3000 Press STORE...

...continues at 0 4000 Press STORE...

...continues at -10 6000 Press STORE...

...continues at -10 8000 Press STORE...

...continues at -10 12500 Press STORE...

...continues at -10 125 Press STORE...

...continues at -10 250 Press STORE...

...continues at -10 500 Press STORE...

...continues at -10 750 Press STORE...

...continues at -10 1000

dB Hz Masking 
level

40 1000 30 Press 
STORE...

...continues at 30 1500 20 Press 
STORE...

...continues at 20 2000 10 Press 
STORE...

dB Hz
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Warble frequency 19 WARBLE FREQUENCY
1 Hz to 20 Hz

Select manual frequency 20 SELECT AC FREQ.
Here you can select (ON) or cancel (OFF) the frequencies to be included for 
automatically changing frequencies when you store AC thresholds.

The frequencies are selected using the FREQUENCY selector.

ON/OFF is selected using the right LEVEL selector.

Note · This setting does not influence the Frequency knob, and accordingly, all frequen-
cies (including inter-octave frequencies) are available when you use the Frequency knob.

However, if the frequency 125 Hz is not included in the SELECT AC FREQ. set-
ting, then it will not be included when you use the Frequency knob. 

Select automatic frequency 21 SELECT BC FREQ.
Here you can select (ON) or cancel (OFF) the frequencies to be included for 
automatically changing frequencies when you store BC thresholds.

The frequencies are selected using the FREQUENCY selector.

ON/OFF is selected using the right LEVEL selector.

Note · This setting does not influence the Frequency knob , and accordingly, all fre-
quencies (including inter-octave frequencies) are available when you use the Frequency 
knob.

Signal unit 22 SIGNAL UNIT
HL 
SPL LED-FLASH 
If SPL is selected, the dB button will flash to indicate that the display is showing 
SPL values and not HL values.

Microphone input sensitiv-
ity

23 MIC INPUT SENSE
Selection of microphone input sensitivity (MIC LED is lit).

If you press and hold MIC, you can adjust the left microphone with the left 
LEVEL selector and the right microphone with the right LEVEL selector.

If you turn the right LEVEL selector without pressing MIC, both right and left 
microphones are adjusted and the display shows an average of the two.

CD/Tape input sensitivity 24 CD INPUT SENSE
Selection of CD/Tape input sensitivity (CD LED is lit).
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If you press and hold CD, you can adjust the left input with the left LEVEL selec-
tor and the right input with the right LEVEL selector.

If you turn the right LEVEL selector without pressing CD, both right and left 
inputs are adjusted and the display shows an average value.

Talk over 25 TALK OVER
(EXTERN if external microphones connected, otherwise INTERN)

Possible settings: 
Frequency selector: 
Switches between dB level fixed (FIX) or dB level relative to any saved threshold 
value (THR) for frequencies 250, 500, 1000, 2000, 4000 Hz.

L <--> R button: Sends the Talk Over signal to the right or left headphone. Press 
twice to transmit the signal to both ears.

When you press and hold TALK OVER, the following adjustments can be made:

Left LEVEL selector:Output level in headphone (dB HL)

Right LEVEL selector:Microphone sensitivity for Talk Over.

Talk back microphone 26 TALK BACK MIC.
Selection of sensitivity for Talk Back microphone.

Monitor ON/OFF 27 MONITOR ON/OFF
Switches the monitor ON or OFF.

Tone/Speech/Masking:Choose the stimulus using the FREQUENCY selector.

On/Off:Enable/disable monitoring of the chosen stimulus using the right Level 
selector.

Monitor left 28 MONITOR LEFT
Selection of volume for left monitor.

Monitor right 29 MONITOR RIGHT
Selection of volume for right monitor. 

Light intensity in LEDs 30 LIGHT INTENSITY
Selection of brightness in LEDs (All LEDs are lit).

Internal beep 31 INTERNAL BEEP
Switches the internal beeper in connection with the patient's response switch, 
and under item change in SETUP, ON or OFF.
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Fault beeps are not removed

Extended range timeout 32 EXT. RANGE
Selection of one of three modes (see description in 3.2.14 The EXT. RANGE 
button  26):

– Auto
– Manual
– Timeout 

Selection of the time interval that passes between the device standing 
untouched and the EXTended (sound intensity) RANGE is deactivated.
If OFF is selected, this safety feature is disabled.

Selectings possibilities: OFF, 20 sec. to 120 sec.

Default: Auto.

Extended range dB-space 33 EXT.R. dB-SPACE
Selection of the sound intensity range below the maximum value for which selec-
tion of EXTended RANGE is permitted

30 dB to 70 dB below max.

Baud rate 34 BAUDRATE
Selection of baud rate for RS232 interface.

9600, 19200 (default value), 38400, 57600.

CD power supply 35 CD POWER SUPPLY
Selection of voltage for CD power supply.

OFF and 1.5 V to 10.0 V set using the right LEVEL selector.

Note · Remember to use an adapter if necessary so that the CD has the correct polarity. 
The centre pin is + and the sheath is 0 V.

Display 36 DISPLAY
Controls display setup. Fixes one of the four left/right configurations:

2

SIGNAL AS L/R • The signal for the left ear is shown on the left 
side, and that for the right ear on the right side. 
Masking is on the opposite side.

SIGNAL AS R/L • The signal for the left ear is shown on the right 
side, and that for the right ear on the left side. 
Masking is on the opposite side.
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Stimuli knob 37 STIMULI KNOB
Controls the functions of the left and right LEVEL knobs:

Default setting 38 DEFAULT SETTING
Sets all SETUP parameters to default.

Press STORE.

The default values are: 

FIX SIGNAL ON L • The signal is shown on the left side, and mask-
ing on the right side.

FIX SIGNAL ON R • The signal is shown on the right side, and mask-
ing on the left side.

FIX SIG. TO L • The signal is controlled by the left LEVEL knob 
and masking by the right LEVEL knob.

FIX SIG TO R • The signal is controlled by the right LEVEL 
knob and masking by the left LEVEL knob.

FOLLOW DISPLAY • The stimuli (signal/masking) controlled by the 
left and right LEVEL knobs correspond to the 
placing (left/right) of the stimuli on the display.

3:   AC TRANSDUCER None

4:   BC TRANSDUCER None

5:   SF TRANSDUCER None

6:   AC MASKING None

7: BC MASKING None

8:   SF MASKING None

9: MASK.PRESENT. Continuous

10: TON MASK. SIG. NBN

11: SPEECH MASK. SIG. SPN

12: SPEECH COUNT FAIL WORDS 20

13: FREQ.CH.AT STORE WARP

14: DB LEV. NEW TRA. 20 dB

15: DB LEV. NEW FREQ No change

16: PULSE FREQUENCY 1.50 Hz
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17: IMPULSE LENGTH 1.50 Sec. 

18: WARBLE MOD.SIZE 5%

19: WARBLE FREQUENCY 5Hz

20: SELECT MANU.FREQ All frequencies on

21: SELECT AUTO.FREQ All frequencies on

22: SIGNAL UNIT HL

23-26 Half gain

27: MONITOR ON/OFF Tone On, Speech On, Masking Off

28 - 30 Half gain

31: INTERNAL BEEP ON

32: EXT.R. TIMEOUT Off

33: EXT.R. dB-SPACE 30 dB below max.

34: BAUDRATE 19200 Baud

36: DISPLAY Fix signal on Left

37: STIMULI KNOB Fix signal to Left
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11 Configuring OTOsuite 

The Configuration Wizard guides you through the process of customizing the vari-
ous features and functions that apply to OTOsuite. 

1. Select Tools > Configuration wizard... 

2. If you wish to connect your test device to the specific module and set up mod-
ule-specific functionalities, click on Configure... next to Audiometry.
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11.1 Audiometry

Audiometers

Connect to the 
device you wish to 
use for testing.

1. Click on the device you wish to use.
– If the device is not listed, check the box My device 

is turned on and ready to be found, and click on 
Search.

2. The first time you select a device, you will be 
prompted to enter the Audiometer license key.

3. Enter the license key.
4. Select the device and click on Next or Close.

Test type

Show SISI test type

Show ABLB test 
type

Show MLD test type

• Click to enable viewing either of these test types as a 
test tab selection on the Audiometry test screens, and 
to access their settings in Tools > Options.
If a User Test is set up to include either of these tests, 
and they have been disabled in this screen, you will be 
prompted to enable them here.
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12 MADSEN Itera II Maintenance and Safety

12.1 Service and repair
It is recommended that you keep the packing material in which the Itera II was deliv-
ered. If you need to send it in for service, the original packing material will ensure 
protection against damage during transport, etc.

On request, your supplier can obtain a service manual from the factory. The service 
manual contains electrical diagrams, descriptions, lists of components and calibra-
tion instructions, etc. 

Warning · For the sake of safety and in order not to void the warranty, the cabinet 
should only be opened and serviced by authorised service personnel at authorised work-
shops. In case of any defects, please make a detailed description of the defect(s) and contact 
your supplier. Do not use a defective instrument.

Note · There are no user-serviceable parts inside the Itera II cabinet. When dismantling 
the Itera II unit there is a risk of electric shock. 

12.2 Cleaning and maintenance
Itera II requires no preventive maintenance. However, it is recommended that you 
observe the following guidelines.

12.2.1 Cleaning the device

Make sure that the instrument is kept clean and free of dust:

• Remove dust using a soft brush, and take special care to remove any accumula-
tions of dirt on or around the buttons on the front panel.

• To clean the cabinet and the front panel, use a soft, slightly damp cloth with a 
small amount of mild detergent on it. Do not allow any moisture inside the 
instrument!

• To clean the display, use a dry cloth or soft brush. Note that the display is lami-
nated for maximum readability and must therefore be treated with care.
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12.2.2 Cleaning accessories

Earphones
The earphones are in constant contact with your patients, and should therefore be 
kept clean. Wipe them regularly with a moist cloth. 

Eartips
The eartips are disposable and therefore should not be cleaned or re-used. There are 
no special requirements for the disposal of the ear-tips. 

If you use the E-A-RTONE® 3A insert phone, note that the standard yellow foam 
insert tips are disposable, and therefore should not be cleaned or re-used. There are 
no special requirements for the disposal of the insert tips.

Bone conductor
The bone conductor should periodically be wiped clean with a dry cloth.

12.2.3 Replacing fuses

To replace or inspect a fuse, proceed as explained below.

Warning ·  
Risk of fire. Before replacing a fuse, first switch off the instrument and disconnect it from 
the mains power supply.

The fuse-holders are located next to the AC power connector (or they are integrated 
with the power connector).

To remove a fuse:

• Unscrew the end of the fuse-holder using a screwdriver with a blade at least 6 
mm wide (or remove the power connector).

Fuse types
The fuse is a push-fit in the end of the fuse-holder. When you replace fuses, use only 
fuses of type T1A L/250 V, 5 mm x 20 mm.

12.3 Calibration
You can download new software to Itera II, and if this involves no change to the 
transducers, Itera II does not need recalibration.

Annual calibration
It is recommended that Itera II, headphones and bone conductors are calibrated 
annually by suitably qualified personnel using the appropriate equipment.

3
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Itera II is dispatched from the factory together with a Test Report (Calibration Cer-
tificate). The Test Report specifies the transducers that have been calibrated (i.e., 
those which have been supplied together with the instrument), according to which 
standards, and the equipment used for calibration. Results are listed for each trans-
ducer at all standard frequencies.

In general, the instrument is calibrated in dB SPL or dB HL using the stated refer-
ence equivalent thresholds; dB HL are related to sound pressure levels, dB SPL = dB 
re 20 μPa, and force levels (dB re 1 μN).

Note · Calibration has been performed only on the transducers supplied! If you wish to 
use any other transducer for testing with Itera II, please contact your local distributor first.
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13 Unpacking and Installing MADSEN Itera II

13.1 Unpacking Itera II
When you receive Itera II, it is packed in special packing material. The packing mate-
rial is designed to provide your Itera II with good and safe protection during trans-
port and shipping.

Remove the instrument and accessories carefully from the packing material. Make 
sure that Itera II has not been damaged during transport. Check that the items on 
the packing list correspond to those delivered.

13.2 Installation

Before you install Itera II
• Before you start using the device, it is recommended that you leave it at room 

temperature for 30 minutes - particularly if it has been stored in very cold or 
warm temperatures, e.g. if it has been in a car.

• Read the User Manual before you connect or use Itera II for the first time.
• Connect required accessories such as the headset, the bone conductor, and the 

Patient Response Switch to their respective connectors on the back panel accord-
ing to the instructions in 13.2.2 Air conduction  128, 13.2.3 Bone 
conduction  128, 13.2.4 External microphone  129, 13.2.4 External 
microphone  129 and the locations described in 3.3 Socket connections - rear 
panel  31. 

Note that the headphone (AC transducer) and SP (SF) transducer connectors and the 
CD/Tape sockets are color coded as described in 3.3 Socket connections - rear 
panel  31.

13.2.1 Location

Place the instrument in a well-ventilated location away from sources of heat.
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13.2.2 Air conduction

Headphones
• Connect the right and left wires (red and blue) from the transducers to the right 

and left AC sockets in the back panel of Itera II (3.3 Socket connections - rear 
panel  31).

Fig. 15 Headset

Insert phones
• Connect the Insert phones to the right and left AC socket or the right and left 

SF socket (3.3 Socket connections - rear panel  31). They must be connected 
according to calibration.

• To verify the calibration, press [AC]/[SF] and the display will show the trans-
ducer calibrated for that output.

Fig. 16 EAR-3A insert phones (only one shown)

13.2.3 Bone conduction

• Connect the bone conduction transducer plug into the BC socket located in the 
back panel of Itera II (3.3 Socket connections - rear panel  31).
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Fig. 17 Bone conductor B71

13.2.4 External microphone

In speech testing and patient communication there are two possible external micro-
phone solutions: 

• Gooseneck, or 
• Boom microphone on the monitor headset. 
Connect the chosen microphone solution to the “EXTERNAL MIC/MONITOR 
HEADSET” socket (3.3 Socket connections - rear panel  31). Connecting one of 
these disables the internal talk-over microphone.

Gooseneck

Fig. 18 Gooseneck microphones
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Monitor headset

Fig. 19 Monitor headset with boom microphone

13.2.5 Free Field

Without Power Amplifier
• Plug the Free Field transducer cables directly into the R-SF and L-SF sockets 

located in the back panel of Itera II (3.3 Socket connections - rear panel  31). 
The sound is then routed out through sound field speakers.

Fig. 20 Free Field without Power Amplifier

With Power Amplifier
• Plug the Power Amplifier cables into the two center sockets in the back panel of 

Itera II.
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Fig. 21 Free Field with Power Amplifier

13.2.6 Powering

1. Plug the power cord into the power socket on the back of the instrument. 
2. Plug the other end of the power cord directly into an AC power outlet with a 

three-wire protective ground. 

13.2.7 Connecting to a PC

See  RS 232 INTERFACE  33 for a description of how to connect the RS 232 
cable to Itera II.

If required, use a USB converter for your RS232 cable. See your accessories list to 
order.

13.2.8 Firmware update - audiometers

If your OTOsuite version contains a more recent firmware for your audiometer, a 
message will appear when next you switch on your device.

It is recommended that you update your audiometer firmware to make sure that your 
audiometer and OTOsuite perform correctly.

Follow the on-screen instructions.

FF cables PA cables
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App. 1 Maximum Non-Destructive Voltage - 
MADSEN Itera II

App. 1.1 Input and output sockets
Maximum non-destructive input voltages for input and output sockets relative to 
earth connection when the instrument is switched on.

App. 1.2 RS232 interface sockets

SP left and right socket 10 V AC ±10 V DC

AC left and right socket 10 V AC ±10 V DC

BC socket 10 V AC ±10 V DC

CD/TAPE left and right socket 12 V AC ±12 V DC

Speech Talk Over socket 12 V AC ±12 V DC

Monitor socket 12 V AC ±12 V DC

Patient Mic/Talk Back socket 12 V AC ±12 V DC

Digital Aux (For future use.) 5 V AC ±5 V DC

Patient Response socket 12 V AC ±12 V DC

DC Power out 30 V AC ±30 V DC

AC mains inlet 1500 V AC ±370 V DC

pin 1 (nc) 240 V AC ± 240 V DC

pin 2 (RxDout) 15 V AC *± 15 V DC

pin 3 (TxDin) 30 V AC *± 30 V DC

pin 4 (DTR) 30 V AC *± 30 V DC

pin 5 (ISO Gnd.) 30 V AC ± 30 V DC
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App. 1Maximum Non-Destructive Voltage - MADSEN Itera II  

RS232 interface sockets 

Relative to pin 5 on the RS232 interface socket.

For information on how to use MADSEN Itera II with a PC, consult your local sup-
plier.

pin 6 (DSR) 30 V AC *± 30 V DC

pin 7 (RTSin) 30 V AC *± 30 V DC

pin 8 (CTSout) 15 V AC *± 15 V DC

pin 9 (nc) 240 V AC ± 240 V DC
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App. 2 MADSEN Itera II Abbreviations

ABLB alternate binaural loudness balance

AC air conduction

AC alternating current

AM amplitude modulation

AUTO automatic

BC bone conduction

CD CD (compact disc) player

CH change

DC direct current

DEF default

EXT external

EXT. R. extended range

EXTERN external

FIX fixed talk over level

FM frequency modulation

FREQ frequency

HIS Hearing Instrument Simulation

HISF Hearing Instrument Simulation Filter

HL hearing level
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App. 2MADSEN Itera II Abbreviations  

 

HP high pass

INT internal

INT interrupter

L left

LCD liquid crystal display

LED light emitting diode

LEV level

LP low pass

MANU manual

MASK masking

MCL Most Comfortable Level

MIC microphone

MICL left external microphone

MICR right external microphone

MILI left internal microphone

MIRI right internal microphone

MOD modulation

NBN narrow band noise

o right ear

P parameters

PC personal computer

PCT percent

R right
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 App. 2MADSEN Itera II Abbreviations 

SF sound field

SIG signal

SISI short increment sensitivity index

SP special output (same as SF)

SPL sound pressure level

SPN speech noise

STEN Stenger

THR threshold

TON tone

TRA transducer

TRANSD transducer

UCL UnComfortable Level

VU volume unit

WARB warble

WBN wide band noise (white noise)

WRB warble

x left ear
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App. 3 Technical Specifications - MADSEN Itera II

App. 3.1 Accessories[1]

TDH39/TC89E headphones 
B-71 bone conductor 
Patient Response switch 
Mains cable 
Audiogram pad 
This User Manual 
HDA 200 headphones for high-frequency audiometry 
Insert phones (E-A-RTONE® 3A) 
Monitor headphones with microphone 
Gooseneck microphones (one right and one left Microphone) for speech audiometry 
and Hearing Instrument Simulation 
Free-field loudspeaker 
Power supply cable from the MADSEN Itera II to CD player 
PA 210 power amplifier for free-field testing

App. 3.2 Technical Specifications

Channels
2 separate and identical channels

Pure tone frequencies

[1] Which accessories are standard and which are optional varies from country to country - please consult your local supplier.

AC and SF: 12 standard 125 - 8000 and 12500 Hz

BC: 250 - 8000 Hz standard frequencies

Insert phones 125 - 6000 Hz standard frequencies

Accuracy: Better than  1 %.
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App. 3Technical Specifications - MADSEN Itera II  

Technical Specifications 

Modulation

Attenuator
1 dB HL / 2.5 dB HL / 5 dB HL step resolution over the entire range

Attenuator accuracy

Between two consecutive attenuator positions:

HL Range
Maximum output will be limited by the transducer.

HIS function

Masking
Narrow band noise, Speech noise and White noise (Wide band noise)

Total harmonic distortion

FM (Warble): 1 - 20 Hz in 1 Hz steps. Mod. width 1% - 25% in 1% 
steps

AM for SISI: 5, 4, 3, 1, 0.75, 0.50, 0.25 dB HL steps

In whole range: better than 3 dB HL

5 dB HL step: better than 1 dB HL

2.5 dB HL step: better than 0.75 dB HL

1 dB HL step: better than 0.3 dB HL

AC: -10 to 120 dB HL at mid-frequencies

BC: -10 to 70 dB HL at mid-frequencies

Low pass frequencies: 250 Hz, 500 Hz, 1 kHz or 2 kHz

High pass frequencies: 1 kHz, 2 kHz, 3 kHz or 4 kHz

Amplification options: 0, 5, 10, 15, 20, 25 dB SPL

Max. output: 130 dB SPL (for TDH39)

Max. gain: 50 dB SPL

Air < 2.5 %
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 App. 3Technical Specifications - MADSEN Itera II 

Technical Specifications

Selectable transducers

Transducer options depend on how the MADSEN Itera II is calibrated.

Outputs

External inputs

DC bias for electric Mic. 
Optional input resistance between: 10 k  and 600Ω.

Interrupter

Bone < 5 %

AC: TDH39, HDA200, and E-A-RTONE® 3A

BC: B71 (Mastoid / Forehead)

SF: TDH39, HDA200, E-A-RTONE® 3A, Free-Field 
amplifier/loudspeaker

AC: 2 x mono jack, 1/4 "

BC: 1 x mono jack, 1/4 "

SF: 2 x mono jack, 1/4 "

CD/Tape: 0.2 to 2.0 Vrms, 10 k  2 x RCA phone

Microphone: 0.002 to 0.02 Vrms, 2 x 8-pole DIN

Talk Back: 0.002 to 0.02 Vrms, 5-pole DIN for all microphones

Normal: The signal is presented when the INT button is pressed.

Reverse: The signal ceases when the INT button is pressed.

Pulse: The signal is pulses

The pulse frequency can be adjusted in the range 0.25 
to 2.5 Hz in 0.25 Hz steps.

Impulse: The signal is presented for a preset period of time: 0.25 
to 2.5 sec., in steps of 0.25 sec.
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App. 3Technical Specifications - MADSEN Itera II  

Technical Specifications 

Operator output
Two stereo monitor sockets (8-pole DIN horseshoe) for headphones. One socket is 
fitted with a Talk Over Mic. Input option. The monitor signal follows the test signal, 
although the volume can be adjusted individually for each channel.

The Talk Back signal from patient to operator is mixed with the monitor signal.

Static force of transducer headbands

RS232 interface

Transport and storage

Operating environment

(Operation in temperatures exceeding -20°C or +60°C may cause permanent dam-
age.)

TDH 39: 4.5 N ± 0.5 N

B-71: 5.4 N ± 0.5 N

Format: 8 data bit, 1 stop bit

Parity: Equal

Baud rate: 9600, 19200, 38400, 57600 Baud

Protocol: XON/XOFF

Temperature: -40 C to + 70 C

Air humidity: 10% to 90%, non-condensing

Air pressure 500 hPa to 1060 hPa

Mode of operation: Continuous

Temperature: +10ºC to +35ºC

Air humidity: 30% to 90%, non-condensing

Air pressure 860 hPa to 1060 hPa.

Warm-up time < 10 min.
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 App. 3Technical Specifications - MADSEN Itera II 

Technical Specifications

Disposal
MADSEN Itera II can be disposed of as normal electronic waste, according to local 
regulations.

Standards

Miscellaneous
Internal power supply to CD player: 1.5  - 10 V, 0.5 V steps 
Software adjustable contrast/brightness on display and LED's. 
Integral Talk Over microphone. 
Digital Aux:   5-pole DIN 

Dimensions Approx. 450 x 290 x 85 mm, 17.7 x 11.4 x 3.3 inches

Weight Approx. 4.5 kg, 9.9 lb.  

Power supply Internal, 100 - 240 VAC, 50/60 Hz

Power consumption < 60 VA

Fuses T1AL/250V

Audiometer: EN60645-1, EN60645-2, EN60645-4, and ANSI S3.6

Patient Safety: Complies with EN 60601-1, Class 1, Type B; U2601-1; 

CAN/CSA-C22.2 NO 601.1-90.

EMC: EN 60601-1-2
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Technical Specifications 
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App. 4 Standards and safety - MADSEN Itera II  
and the Audiometry Module

App. 4.1 MADSEN Itera II

App. 4.1.1 Symbols used

App. 4.1.2 Warning notes

• Do not use the instrument in the presence of flammable anaesthetics (gases).
• No parts may be eaten, burnt, or in any other way used for purposes other than 

audiometry or the fitting of hearing instruments.
• The instrument and any device to be connected which has its own power supply 

should be turned off before any connections are established.

MADSEN Itera II is marked with this symbol to indicate compli-
ance with Type B requirements of EN60601-1.

The MADSEN Itera II audiometer and this manual are CE-
marked according to the Medical Devices Directive 93/42/EEC.

Warning · MADSEN Itera II is marked with this symbol when it 
is important that the user refers to associated warnings given in this 
manual. Please pay special attention to these warnings.

Classified with respect to electrical shock, fire, mechanical and 
other specified hazards only in accordance with UL2601-1 and 
CAN/CSA-C22.2 NO 601.1-90 

The power supply to the device has been interrupted.

The instrument is marked with this symbol to indicate that it is 
electronic equipment covered by the Directive 2002/96/EC on 
waste electrical and electronic equipment (WEEE).

x x x x
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MADSEN Itera II 

• It is recommended that an annual calibration be performed on headphones and 
bone conductor (see Ch. 9). Furthermore, it is recommended that calibration be 
performed if the equipment has suffered any potential damage (e.g. headphone 
dropped on the floor). Note that calibration has been performed only on the 
transducers supplied! If you wish to use any other transducer for testing with 
MADSEN Itera II, please contact your local distributor first. 

• For safety reasons, accessories connected to the equipment's outlet fittings must 
be identical to the type supplied with the system.

• This class of equipment is allowed in domestic establishments when used under 
the jurisdiction of a health care professional.

• Unwanted noise may occur if MADSEN Itera II is exposed to a strong radio 
field, and such noise may interfere in the process of recording a correct audio-
gram. Many types of electrical devices, e.g. mobile telephones, may generate 
radio fields. We recommend that the use of such devices in the vicinity of MAD-
SEN Itera II is restricted as much as possible.

The bone conductor cable and insert phone (E-A-RTONE® 3A) cable are not to be 
removed or tampered with while connected to MADSEN Itera II. Either disconnect 
the bone conductor entirely from the instrument, or ensure that the instrument itself 
is disconnected from the mains.

When assembling an electro-medical system, the person carrying out the assembly 
must take into account that other connected equipment which does not live up to 
the same safety requirements as this product may lead to a reduction in the overall 
safety level of the system.

When selecting accessories connected to the RS232 socket and DC output, the fol-
lowing points must be considered:

• Use of connected equipment in a patient environment
• Proof that connected equipment has been tested in accordance with EN60601-1 

and/or EN60601-1-1 and UL2601-1 and CAN/CSA-C22.2 NO 601.1-90
Caution · Grounding continuity should be checked periodically.

Avoid using extension cables. The increased length of the cable may increase the 
resistance of the protective earth conductor beyond an acceptable level.

Caution · Operating at the wrong voltage may blow the fuses!

For continued protection against fire hazard, replace fuses with the same type and rat-
ing only.

1

2

3
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 App. 4Standards and safety - MADSEN Itera II and the Audiometry Module 

The OTOsuite Audiometry Module

App. 4.2 The OTOsuite Audiometry Module
The Audiometry Module and this documentation are CE-marked according to the 
Medical Devices Directive 93/42/EEC.

Used in error messages if program fails. See the detailed information in the dialog 
box.

App. 4.2.1 Manufacturer

GN Otometrics A/S 
2 Dybendalsvaenget, DK-2630 Taastrup, Denmark 
T: +45 45 75 55 55, F: +45 45 75 55 59 
www.otometrics.com

 

App. 4.2.2 Responsibility of the manufacturer

The manufacturer is to be considered responsible for the effects on safety, reliability, 
and performance of the equipment ONLY IF:

• All assembly operations, extensions, re-adjustments, modifications or repairs are 
carried out by personnel authorised by the manufacturer.

• The electrical installation to which the equipment is connected is earthed and 
complies with IEC requirements.

• And the equipment is used in accordance with the instructions for use.
The manufacturer reserves the right to disclaim all responsibility for the operating 
safety, reliability and performance of equipment serviced or repaired by other parties.

x x x x

http://www.otometrics.com
http://www.otometrics.com


148 Otometrics

App. 4Standards and safety - MADSEN Itera II and the Audiometry Module  

The OTOsuite Audiometry Module 
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Index

A
abbreviations 135
ABLB 86
AC connection 32
AC key 21
AC masking

select transducer 103
AC transducer

select headphones 102
accessories

connections 31
specifications 139

Aided Speech test
the Aided Speech screen 51

Air conduction
testing 65
with masking 69

air conductor 21
AC connection 32

alternating frequency
Fowler 30

amplitude 30
annual calibration 124
attenuator

specifications 140
steps 29

Audiogram
combined, enabling/disabling 38
show combined view, Audiogram Module 38
show split view, Audiogram Module 38
viewing frequency range 38
viewing left-right 38
viewing legend box 38
viewing right-left 38
work area in screen 48
work area in screen, Audiogram Module 45

Audiogram symbols, Audiogram module 48 • 50
Audiogram symbols, Itera II 18
Audiometry

basic functions 35
menu bar 36
OTOsuite toolbar 36
user interface 35

Audiometry module
main window 35

B
baud

rate setting 111
BC connection 32
BC key 21
BC masking

select transducer 103
BC transducer

select bone conductors 102
beep

function 20
ON/OFF, setting 110

binaural speech test
input selection 79
input sensitivity 79
masking 81
masking level 82
mixing input signals 80

Bone conduction
testing 67

bone conduction
BC transducer 102

bone conductor 21
BC connection 32
calibration 124

butterfly 105

C
Cables

connecting test equipment 59
calibration 124

annual 124
certificate 125

CD
power supply voltage, setting 111
selection 23

CD key 23
CD/tape

connection 32
power supply 33
select input sensitivity 109

cleaning 123
accessories 124
device 123
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Combined audiogram
enabling/disabling 38

Configuration Wizard 115
connections

AC 32
accessories 31
BC 32
CD/TAPE 32
DC POWER OUT 33
EXTERNAL MIC./MONITOR 
HEADSET 32
headphone 32
MONITOR 32
PATIENT RESPONSE 33
RS232 33
SP (SF) 32
supply voltage 33
TALK BACK 32

Control Panel
Audiometry description 39

controls 19
counter

start or stop 25
Curves and symbols 52

selecting 39

D
data

transmission 24
data transmission 24
dB

level for new frequency 106
level for new transducer 106
space setting 111

dB STEP key 29
DC POWER OUT connection 33
DC POWER OUT voltage 30
default settings 112
default test parameters 102
delete

measuring points 23
thresholds 23

Device - software interfacing 11
display 17

setup 111

E
ear selection 27
ERASE key 23
EXT. RANGE key 26
extended range

dB-space, setting 111
on or off 26
timeout, setting 111

EXTERNAL MIC./MONITOR HEADSET 
connection 32

F
Fetch test results from audiometer 39
filter

HIS 93
Firmware update, test devices (Aud.) 131
Fowler 86

alternating tone frequency setup 27
storing results 87

frequency
butterfly 105
change test f. 26
change with STORE 104
changing 29
dB level for new f. 106
pulse 108
select automatic 109
select manual 109
specifications 139
warble 109
wrap 104

FREQUENCY key 29
Frequency range, audiogram

viewing 38
front panel 19

display 17
functions

AC 21
BC 21
beep 20
CD 23
dB STEP 29
ERASE 23
EXT. RANGE 26
FREQUENCY 29
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IMPULSE 22
input signal 23
INT, left 31
INT, right 31
LEVEL, left 30
LEVEL, right 30
LR 27
MASK 28
MASK LOCK 28
MASK OFF 28
MASK ON 28
MIC 23
MIC. 24
PULSE 22
RESPONSE 23 • 25
REVERSE 23
SETUP 27
SF 21
SIGNAL 22
SPECIAL 21
SPEECH 21
START/STOP 25
STORE 26
TALK BACK 28
TALK OVER 24
TONE 21
TRANSD. 21
WARBLE 22
XMIT 24

fuses
fuse types 124
replacement 124

G
gooseneck microphones

connection 32

H
headphones

calibration 124
Hearing Instrument Simulation 88
Hearing Instrument Simulator

filter 93
master volume regulation 92
reference level 91

specifications 140
value selection 30

HIS 88
HL

range specifications 140
selection 109

I
Icons

combined view, Audiogram Module 38
split view, Audiogram Module 38

impulse
length 108
time 30

IMPULSE key 22
input sensitivity 30

binaural 79
CD/tape 109
microphone 109
monaural 77

input signals
binaural 80
CD 23
microphone 23
REVERSE 23
selection 23

installation
connections 31
location 127
powering 131

instrument, overview 17
INT, left key 31
INT, right key 31
intended use 11
interface cable

connection 33
Interfacing

OTOsuite modules, audiological test 
equipment 11

internal microphone 24
interrupter

specifications 141
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interrupting speech signal 78

K
keys 19

AC 21
BC 21
CD 23
dB STEP 29
ERASE 23
EXT. RANGE 26
FREQUENCY 29
IMPULSE 22
input signal 23
INT, left 31
INT, right 31
LEVEL, left 30
LEVEL, right 30
LR 27
MASK 28
MASK LOCK 28
MASK OFF 28
MASK ON 28
MIC 23
PULSE 22
RESPONSE 23 • 25
REVERSE 23
SETUP 27
SF 21
SIGNAL 22
SPECIAL 21
SPEECH 21
START/STOP 25
STORE 26
TALK BACK 28
TALK OVER 24
TONE 21
TRANSD. 21
WARBLE 22
XMIT 24

L
LEDs

light, setting 110
Left - Right audiogram

viewing 38

Legend
Audiometry 48 • 50
Speech Mapping 50

Legend box, audiogram
viewing 38

LEVEL, left key 30
LEVEL, right key 30
location of instrument 127
LR key 27

M
Main window

Audiometry module 35
maintenance 123

replacing fuses 124
manufacturer 147
MASK key 28
MASK LOCK key 28
MASK OFF key 28
MASK ON key 28
Masking

air conduction 69
masking

binaural 81
level, binaural 82
monaural 77
on/off, lock 28
select AC transducer 103
select BC transducer 103
select presentation 103
select SF transducer 103
select stimulus for speech test 104
select stimulus for tone test 104
selecting m. transducer 29
signal 31
SISI 85
with monaural/binaural test signals 96

Masking Assistant 54
Masking assistant

enabling/disabling 37
master volume regulation

HIS 92
MCL, Itera II 83
measuring points

deleting 23
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Menu bar
Audiometry 36

microphone
internal 24
select input sensitivity 109
selection 23
talk back connection 32

modulation
specifications 140

modulation size
warble 108

monaural speech test 75
input selection 75
input sensitivity 77
masking 77
speech in noise 80
word count 78

monitor
left, setting 110
ON/OFF setting 110
right, setting 110

MONITOR connection 32
monitor headset

connection 32
Most Comfortable Level, Itera II 83

N
Navigating in Audiometry 35
No response 26

O
ON/OFF

power switch 34
Overlays

viewing 37
overview, instrument 17

P
parameters

AC masking 103
AC transducer 102
baud rate 111
BC masking 103
BC transducer 102
CD power supply 111

CD/tape input sensitivity 109
changing 27
dB level new frequency 106
dB level new transducer 106
default settings 112
display setup 111
extended range dB-space 111
extended range timeout 111
frequency change with STORE 104
impulse length 108
internal beep 110
item selection 30
light in LEDs 110
masking presentation 103
microphone input sensitivity 109
monitor left 110
monitor ON/OFF 110
monitor right 110
pulse frequency 108
save test setup 102
select automatic frequency 109
select manual frequency 109
set default test parameters 102
setup 99
SF masking 103
SF transducer 103
shortcut 99
signal unit 109
speech count 104
speech masking signal 104
stimuli knob 112
talk back microphone sensitivity 110
talk over 110
tone masking signal 104
warble frequency 109
warble modulation size 108

patient communication
talk over 24

patient response
shown on display 23 • 25
switch connection 33

PATIENT RESPONSE connection 33
pc interface

cable connection 33
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power switch 34
powering 131
Preparing for testing

connecting cables 59
pulse frequency 30
PULSE key 22

R
range,extended 26
receiving the instrument 127
reference level

HIS 91
replacement

fuses 124
RESPONSE key 23 • 25
REVERSE key 23
Right - Left audiogram

viewing 38
RS232 connection 33

S
safety 145
save test setup 102
Screens

Aided Speech 51
Audiometry module main window 35
Speech 48
Tone, Audiogram Module 45

sensitivity
talk back microphone 110

Settings
Control Panel 39

settings
default s. 112

setup
parameters 99

SETUP key 27
SF key 21
SF masking

select transducer 103
SF transducer

select headphones/free-field 
loudspeaker 103

shortcut
parameters 99

SIGNAL key 22
signal unit

select 109
SISI 83

changing number of small increments 27
masking 85
signal type selection 30
storing results 85

Sound field testing 67
SP (SF) connection 32
special Hearing Instrument Simulation 
(HIS) 88
SPECIAL key 21
special tests 83

Fowler (ABLB) 86
SISI 83
Stenger 87

special transducer 21
specifications 139

accessories 139
speech in noise 80
SPEECH key 21
Speech test

the Speech screen 48
speech test

heard words 31
masking setup in one ear 27
mixed signals 27
select number of words 104
test signal in both ears 27
unheard words 31

speech testing 75
interrupting speech signal 78
monaural 75
word count 78

SPL
selection 109

standards 145
start

counter, timer 25
START/STOP key 25
Stenger 87
stimuli

knob setting 112
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stimulus
impulse 22
pulse 22
selection 22
warble 22

stop
counter, timer 25

STORE key 26
storing results

Fowler 87
SISI 85

supply voltage
connection 33

symbols 145
Symbols and curves

selecting 39
Symbols, audiogram module 48 • 50
Symbols, audiogram, in Itera II 18

T
talk back

level 30
microphone sensitivity 110
volume 28

TALK BACK connection 32
TALK BACK key 28
talk over

settings 110
TALK OVER key 24
technical specifications 139
Test devices (Audiometry)

firmware update 131
Test equipment

connecting cables, Audiometry 59
test frequency

change 26
test parameters

changing 27
set default 102

test report 125
test setup

save 102
test signals 31

monaural/binaural and masking 96

test types 21
Testing

air conduction 65
bone conduction 67

testing 65
ABLB 86
Fowler 86
Hearing Instrument Simulation (HIS) 88
monaural speech t. 75
SISI 83
special tests 83
speech t. 75
Stenger 87

Tests
Aided Speech screen 51
controlling from Control Panel 39
Speech screen 48
Tone screen, Audiogram Module 45

thresholds
deleting 23
store 26

timer
start or stop 25

TONE key 21
Tone test

the Tone screen, Audiogram Module 45
Toolbar

Audiometry 36
Tools menu (Aud)

Curves and symbols 39
fetch test results from audiometer 39

TRANSD. key 21
transducers

AC 21
AC connection 32
AC, headphones 102
BC 21 • 102
calibration 125
dB level for new t. 106
selection 21
SF 21 • 103
SF connection 32
specifications 141

transmission
data 24
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U
UCL, Itera II 83
UnComfortable Level, Itera II 83
User interface 35

V
value selection

HIS 30
View menu (Aud)

audiogram legend 38
combined audiogram 38
frequency range 38
left-right audiogram 38
masking assistant 37
Overlays 37
right-left audiogram 38

voltage
maximum non-destructive 133

W
warble

frequency 109
modulation size 108
selection 30
setup selection 30

WARBLE key 22
warning notes 145
word count 30 • 78

failed word 31
heard word 31
select method 104

wrap 104

X
XMIT key 24
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